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About This Guide
This guide describes the procedures for accessing and presenting the data maintained
by the IBM® TRIRIGA® system.

Intended Audience
This guide is for Report Writers who use the reporting capabilities of the IBM TRIRIGA
Application Platform.

Prerequisites
This guide assumes the reader has a basic understanding of the IBM TRIRIGA
Application Platform and the fundamental concepts required to operate the Webbased IBM TRIRIGA system.

Support
IBM Software Support provides assistance with product defects, answering FAQs, and
performing rediscovery. View the IBM Software Support site at
www.ibm.com/support.
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1. Overview
There are multiple solutions for accessing and presenting the data maintained by the
IBM TRIRIGA system. Simple tabular reports, queries, and graphs that combine data
from multiple records into a single presentation can be produced using the IBM
TRIRIGA Report Manager.
If you need a report presentation that is beyond the capabilities of the IBM TRIRIGA
Report Manager, you can use the IBM TRIRIGA Advanced Reporting feature. IBM
TRIRIGA uses Eclipse Business Intelligence Reporting Tools (BIRT) as the enabling
technology for the Advanced Reporting feature.
With the assistance of Microsoft Word or Excel, the contents of a single record can be
presented with most of the flexibility that Microsoft Word and Microsoft Excel offer
for the presentation of documents and forms. This type of data presentation is called
a form report.
The chart below illustrates the primary differences between the reporting methods.
Characteristic

IBM TRIRIGA Reports

Microsoft Word
Form Report

IBM TRIRIGA
Advanced Reports

Ease of Creation

Easy

Moderate

Technical

Formatting Capabilities

Minimal

Moderate

High

Can Include Logos & Graphics

No

No

Yes

Requires Report Server

No

No

No

Data Access

Multi-record

Single Record

Multi- and Single
record

Drill through to underlying
data

Yes

No

Yes

In deciding which reporting method to use, consider the following key questions:


Is my objective to reduce or eliminate paper?  Yes, use IBM TRIRIGA Report
Manager



Are the recipients of the report IBM TRIRIGA users?  Yes, use IBM TRIRIGA
Report Manager



What level of formatting and graphics are required?  High, use IBM TRIRIGA
Advanced Reporting

The remainder of this guide describes each reporting solution. Chapter 2 provides
information about the IBM TRIRIGA Report Manager, including the creation of Word
and Excel reports. Chapter 3 provides information about the IBM TRIRIGA Advanced
Reporting feature.
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Tip – The documentation for the IBM TRIRIGA Connector for SAP BusinessObjects is located
in the IBM TRIRIGA Application Platform 3 Knowledge Center. Customers with licenses for
the IBM TRIRIGA Connector for SAP BusinessObjects can submit a request for the software
through IBM Support.

Naming Conventions
IBM TRIRIGA follows a set of naming conventions in its applications and in custom
development that it provides on behalf of its customers. Follow these naming
conventions to reduce unexpected interactions between IBM TRIRIGA’s applications
and applications created by others, and to help ensure that future upgrades go more
smoothly.
Element

Naming Convention

Name Prefix

A three character customer prefix is assigned to all implementations,
typically cst. For IBM TRIRIGA applications, the prefix is tri.

Report or Query

cst+“-” + Form Name (or Business Object Name or Module Name if
Report/Graph) – Keyword – Context
There are no spaces between the cst- and the tri object name.
For example: cst-triPurchaseOrder – Workflow – POs for Current
Year.
If the query references a new or customized object:
Form Name (or Business Object Name or Module Name) – Keyword –
Context
For example: cstEmployee – BIRT – Employee Contact Details

Keywords are:
BIRT

Query with linked BIRT document

Debug

Query to help isolate data issues

Display

Query to display data in query sections

Filter

Query to filter data for other queries via
Association filters

© Copyright IBM Corporation 2011, 2015.
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Element

Naming Convention
Find

Query for Find action of a locator or section

Formula

Query to provide input values for extended
formulas

Graph

Graph reports intended for end users

Graphics

Graphics Editor report

GUIMetric

Query for metric in a form

HGrid

Hierarchical query for nesting queries

Patch

Query used in patch helpers

Portal

Query for portal section

Report

Report intended for end users

Reserve

Calendar/Reserve-based query of data
associated with record

Summary

Summary Report intended for end users

Subquery

For the bottom level of an HGrid query
structure

Workflow

Query for workflow Query task

Context should include filters to states, data filters, association
filters, if editable, and the like. For queries tied to a
$$RECORDID$$ or other platform key, make sure to include the
type of context record in the context part of the name.
The ID of the report should be CUSTOM, or use your company’s
numbering standards for reports. SYSTEM is reserved for IBM TRIRIGA
delivered reports.
Naming Convention for Labels:
Form Label (or Business Object Label, or Module Label) – Context
Context should describe what the report displays to the user.
For example: Employees – All Associated Active Employees

© Copyright IBM Corporation 2011, 2015.
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Print
The Printlink on the top right of a form displays sections from all non-system tabs in
the form in a read-only pop-up window. Review the information displayed
automatically by the system in the Print link before you create a report to print a
form.
In the printer-friendly window, the sections in the first tab of the form display first,
then the second tab, and so on. Each section displays in the defined form layout,
preceded by the section name and a line. Query sections and similar sections contain
no actions or pagination. Tabs within multi-tab sections display in the order in which
they are defined in the Data Modeler. Sections in system tabs (e.g., Calendar,
Associations, Audit, and Audit Actions) do not display.
Any multi-row section (including a query section) can display up to 1000 records.
Runtime filters, actions (e.g., Export and Refresh), or pagination (e.g., a Show dropdown or Next page) are not available. Where present, the system uses default filters.
If a section spans more than one page, your browser software determines the page
break. A non-interactive message, “There is more data…”, displays at the end of a
section that contains more than 1000 rows of records.
A section with an embedded advanced report does not display on the printer-friendly
page; nor do Gantt charts, URLs, or Metric charts. The view supports any embedded
images that the user’s browser supports natively without an external viewer (e.g., GIF
and JPG).
A user sees only the section content that their security level authorizes. To change
the graphic displayed at the top of the report, change the image stored in
COMPANY_LOGO in the Document Manager.
To print the printer-friendly view, click the Print hyperlink in the upper right corner
of the display. The user’s native print dialog box appears.

© Copyright IBM Corporation 2011, 2015.
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2. IBM TRIRIGA Report Building
IBM TRIRIGA’s native reporting solution is called the Report Manager. It can be used
to create tabular reports and graphs that can be displayed as reports, as portal
components, or in navigation items. IBM TRIRIGA reports include filter, search, and
sort capabilities as well as the ability to link to other reports. The tool for building
reports is the Report Builder.

Report Manager
The starting point for creating or managing IBM TRIRIGA reports is the Report
Manager. To access the Report Manager:
Step
Step 1

Sign in to the IBM TRIRIGA application.

Step 2

Select the My Reports menu item. The Report Manager displays.

Every user with a My Reports menu item in the first level of the menu bar has a My Reports tab.
Depending on your security permissions, you also may see the Community tab, System Reports
tab, and the Administration tab.
•

•

•

•

My Reports tab contains reports that you created for your own purpose or that have been shared
with you. With appropriate security, you may share a report in the My Reports tab with groups of
users.
Community tab contains reports that your company’s administrator has designated as shared. Any
user with security access to the objects defined in a report can run the report or copy the report
into My Reports and customize for their own purpose.
System Reports tab contains reports used by the IBM TRIRIGA applications. Generally, a company
restricts access to the System Reports tab to designers and administrators who are responsible for
the system.
Administration tab contains all reports from every My Reports tab in the system. From here,
administrators can change the owners of reports, copy reports, share reports with groups, and
delete reports. Most installations restrict access to the Administration tab to system
administrators.

My Reports
My Reports is what it sounds like, your collection of reports. A report displays in the
My Reports tab of the Report Manager if you created it or if it is shared with a group
of which you are a member.
Your view of My Reports may be different from that described in this user guide.
Depending on your system security, you may see some or all of the features.

© Copyright IBM Corporation 2011, 2015.
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The column headings displayed in the My Reports tab follow. You click the hyperlink
to open the Report Builder definition of a report. Use the filters in the column
headings to find the report of interest.
Column Heading

Description

Blank

Displays the Run Report icon . When you click the icon, the system
generates the report and displays it in a separate window.

Title

The title of the report.

Name

The system name of the report.

Tag

A name that can be filtered from the Report Manager. Use this field
to build collections of related reports.

Form

The display for the report. If it is a module- or business object-level
report, this field shows a comma-separated list of forms.

Display Type

The kind of report. Values include –All-, Report, Graphic,
Summary, Chart, Hierarchy, and Metric.

Owner

The user who built the report.

Shared Groups

The groups with which you shared this report or that shared it with
you.

The actions available on My Reports in the Report Manager follow.
Action Name

Description

New

Opens the form for creating a new report record.

Copy

Makes a copy of a selected report and pastes the copy in your My
Reports tab. The copied version has the words “Copy of” at the
beginning of the Name. To copy a report, select the check box and
click Copy.

Delete

Removes the selected report permanently from the Report Manager.
To delete a report, select the check box and click Delete. Click OK
in the delete confirmation window.

Copy as Community Report

Makes a copy of the selected report and pastes the copy into the
Community tab. The copied version has the words “Copy of” at the
beginning of the Name. To copy a report to the Community tab,
select the check box and click Copy as Community Report. You see
this action only if you have security access to System Reports.

© Copyright IBM Corporation 2011, 2015.
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Action Name

Description

Share Report

Provides the report to the groups you specify. The system only offers
groups with security permissions to view the underlying data in the
report as candidates for sharing. To share a report, select the check
box, click Share Report, select the groups, and click Accept.

Creating a New My Report
From My Reports in the Report Manager, follow these steps to create a report.
Step
Step 1

To create a report, click New.

A description of each action at the top of the report form follows. Some actions only
appear after the form is saved.
Action Name

Description

Save

Saves the current report definition to the report record.

Save & Close

Saves the current report definition to the report record and closes
the form.

x

Closes the form. The system does not save any changes made since
the last Save or Save & Close action.

Run Report

Generates the report and displays it in a secondary window. Only
available after the report record has been saved.

Validate

Only available for Metric reports. Use Validate as a debugging tool to
ensure the report is properly constructed. For example, for a
Line-Bar Combo chart, the system checks that the main query and
the line data source query have identical filters specified and
identical Group Bys specified.

The subsequent sections in this chapter describe each tab in the report form for each
report type. The following list describes the report types:


Report is a basic tabular report. A report is listed in a navigation item.



Graphic is outside the scope of this guide. For more information, go to the
IBM TRIRIGA Application Platform 3 Knowledge Center and select Administering
IBM TRIRIGA Application Platform>Managing graphics.
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Chart displays the data in a chart. Four kinds of charts are available: pie, bar,
line, and stacked bar.



Summary is a tabular report. It differs from other reports in the way that detail
records are handled. In a non-summary report, all detail records that
contribute to totals display in the report. A Summary report shows the totals
without the detail records.



Hierarchy uses a query to show information up and down a hierarchy.



Metric aggregates data in a table or chart with drill paths, filters, and related
reports. You can create metric reports based on instance data (business object
data) or on Fact Tables (as done in the IBM TRIRIGA Workplace Performance
Management, IBM TRIRIGA Real Estate Environmental Sustainability, and IBM
TRIRIGA Strategic Facility Planning products).

My Report: Report
When a report record’s type is Report, the result lists records in a table-like format.

My Report Tab
Define the report and its scope in the My Report tab of the report record.
Step
Specify identifying information about the report.
Step 1

Specify the Nameof the report.
Names must be unique. Use the naming conventions described in the Naming Conventions
section in this user guide.

Step 2

Specify the IDto further identify the report. Use CUSTOM or your company’s numbering
standards for reports.

Step 3

Specify the Header (Title). This is the text that shows at the top of the report.

Step 4

To use an additional grouping for filtering, specify the Tag.

Step 5

Specify a complete Descriptionof the report.

Step 6

In the Type field, select Report.
The Business Objects, Options, Related Reports, and Security sub-tabs provide more
particulars about the report.

© Copyright IBM Corporation 2011, 2015.
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Business Objects Sub-Tab
The Business Objects sub-tab identifies the data available to this report record.
Step
Step 1

In the Business Objects sub-tab, select Add Business Object.

Step 2

Select the Module.

Step 3

Select one or more Business Objects.
If you select –All-, the report works with any data from any business object in the
specified module.
If you select the name of one or more business objects, the report works only with data
from the specified business objects.
To select multiple business objects, hold the Ctrl or Shift key and click your selections. If
you select multiple business objects, you can only select fields from the base business
object.

Step 4

Select one or more Forms.
If you select –All-, the data included in the report will not be filtered by form. If you
select the name of one or more forms, only data associated with the specified forms are
included in the report. To select multiple forms, hold the Ctrl or Shift key and click your
selections.

Step 5

Click OK.

Step 6

Click Save.
The Run Report action becomes available. Use Run Report any time you want to test
your report design.
The Edit and Remove actions become available to manage the list in the Business
Objects sub-tab.

Step 7

To edit a business object line item, either click the hyperlink or select the radio button
and click Edit.

Step 8

Optional: Select other business objects.

Step 9

Click Add Business Object.
To add a child business object, select the parent business object before clicking Add
Business Object.

© Copyright IBM Corporation 2011, 2015.
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Step
Step 10 Select the Module.
Step 11 From the Business Object list, select the business object.
To select multiple business objects, hold the Ctrl or Shift key and click your selections.
Step 12 Select the Associated Options.
To select multiple associated options, hold the Ctrl or Shift key and click your selections.
Step 13 Optional: Deselect Show only Associations defined in Data Modeler.
This check box is selected by default to help limit the number of associations that appear
in drop-down boxes. If deselected, the form displays all modules, all business objects
relative to the selected module, and all association types in the system.
Step 14 To designate this object as the Primary Associated Business Object, check the box.
The Primary Associated Business Object check box displays only for direct descendants,
i.e., child associations. By default, it is selected for the first child business object added.
If you remove the designated primary associated business object, the system designates
the next associated business object in the tree as the primary associated business
object.
Step 15 Click OK.
The new object appears in the Business Objects sub-tab under the selected parent
business object. Indentation identifies parent business objects and their children.
When an associated business object is the Primary Associated Business Object, it is
denoted by a purple square after the module name in the Module column.
The Remove action does not apply to the primary business object. To change the
primary business object, edit its properties.
To remove a non-primary business object, select the business object and click Remove.
If you remove an associated business object, you cannot use the fields from that business
object for the report.
If you remove a business object that is part of a hierarchical list, the system also
removes its children.
Step 16 Click Save.
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Options Sub-Tab
The Options sub-tab contains elements that are unique to the Report type.
Step
When the report type is Report, the Options sub-tab presents the following options.
Step 1

Select a value for Data Scope. The default value is Active Project.
The Data Scope limits the data that are accessible to the report.

Value

Description

Active
Project

The data available to the report is restricted to the active project. If the
parent record is a capital project, the active project is the record itself. If the
parent record is not a capital project, the active project is the project in
which the parent record resides.

Company

Only data that exists outside a project is accessible to the report.

All
Projects

The report includes all data, without regard to project or company.

Step 2

For Random Result Count, specify a value or leave the 0 (zero) default.
Use Random Result Count if there are so many data records that including all of them in
a report would not be useful or practical.
The default value is 0 (zero). If this field is set to a positive number, the report includes
only the specified number of records randomly chosen from the complete set of data.

Step 3

To fix the left-hand columns in the report, specify the number of columns in Fixed
Column Count. The default value is 0 (zero). Limit the fixed columns to five or less.
Fixed columns do not move as the user scrolls the report horizontally. After the report
runs, users can identify the fixed columns because they have a thicker border to the
right of the last fixed column.

Step 4

To specify the default size when the system runs the report, use Result Size.
The default value for this drop-down box is for it to be empty, in which case the
platform determines the result size.

© Copyright IBM Corporation 2011, 2015.
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Step
Step 5

To specify an Excel Template, click the Search icon

.

The data displayed in a report can be formatted as a Microsoft Excel spreadsheet by
applying an Excel template retrieved from the Document Manager.
You can use the Name field to search for Excel templates that start with the text you
specify. Use the % character in the Name field as a wild card to widen your search to any
word in the name. For example, type %security to find a template with the word
security anywhere in the name.
Step 6

Select the Excel template and click Accept.

Step 7

To enable the user to specify runtime filters to set initial criteria before the report
executes, select Prompt Before Query.
When the Prompt Before Query check box is deselected, the report executes
immediately when the user selects it. SelectPrompt Before Query for all performanceintensive reports.

Step 8

For Editable, select Yes or No.
Editable determines whether a user can edit the values in the records displayed in the
report directly from the report.

Step 9

Click Save.

Related Reports Sub-Tab
A related report is a self-contained report that has its own definition and format. Its
usual purpose is to display additional information the viewer might find relevant. A
main report can have more than one related report. A related report cannot have
another related report. Values can be passed between a main report and a related
report using shared variables. Generally, a related report contains a reference back to
the main report. Specify any related reports in the Related Reports sub-tab.
Step
When the report type is Report, the Related Reports sub-tab presents the following options.
Step 1

To add a related report, select Add.
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Step
Step 2

On the section bar, click the Filter icon

Step 3

To restrict the reports displayed to only one report type, select a report type.

.

The default is Report. To see all types of reports, select All.
The report types are explained elsewhere in this chapter.
Step 4

Select the Module. The drop-down box contains only modules for which you have security
access.
The system displays My Reports and Community reports (designated by the C) matching
the selected report type and module.

Step 5

Select the check boxes of the related reports.

Step 6

Click OK.
When available, clicking a hyperlink opens the definition of that report.
Related reports appear in the presentation in the same sequence as they appear in the
Related Reports sub-tab, from top to bottom.

Step 7

To change the sequence, click the arrows in the Order column to move a related report
up or down in the list.

Step 8

Click Save Order.

Step 9

To delete a related report, select the check box and click Remove.

Step 10 Click Save.

Security Sub-Tab
The Security sub-tab names groups that can access this report.
Step
When the report type is Report, the Security sub-tab presents the following options.
Although not shown in the Security sub-tab, the system automatically adds the user creating the
report to the Security Access section. The owner has full access privileges.
Use the Add action on the Security Access section bar to grant access to groups.
Step 1

Click Add.
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Step
Step 2

Select the check boxes of the groups to have access to the report.

Step 3

Click Accept.
By default, every group listed has View access.

Step 4

To grant additional access to a group, select the check box next to All, Edit, Delete,
Copy, or Share.

Step 5

To delete a group, select the check box and click Remove.

Step 6

Click Save.

Columns Tab
The Columns tab defines which fields to use in the report. The information in the
Columns tab is organized into three sections:
•
•
•

The Business Object section on the upper left indicates the source business objects.
The Columns section on the lower left identifies which fields in the selected business object to
include in the report.
The Display Columns section on the right specifies the order in which the selected fields are
presented and the labels used to identify them.
Step
Business Object Section
Step 1

Select the Business Object. The fields in the selected business object display in the
Columns section.
The business objects listed in the Business Object section are from the Business Objects
sub-tab in the My Report tab.

Columns Section
Step 2

Select the check box for each field to include in the report. The system adds the
selected fields to the Display Columns section.
The fields displayed in the Columns section come from the selected business object.
When you select a different business object, the fields displayed in the Columns section
change but previously selected fields in the Display Columns section remain.
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Step
Display Columns Section
When you select a check box in the Columns section, the field appears in the list in the Display
Columns section.
Clearing a check box in the Columns section removes the field from the Display Columns list.
The Field column shows the field’s label and system name.
Step 3

To change the sequence in which the fields display, select a field and click Move up,
Move down, Move to top, or Move to bottom.

Step 4

To change the label that displays for a field, edit the text in the Report Labeltext box.

Step 5

To specify a percentage of the display space for a field, specify a numerical value in the
Width text box.

Step 6

To remove a field, select the field and click Remove.

Step 7

Click Save.

Order & Group Tab
The Order & Group tab defines the layout of the data in the report. You can organize
the layout by group, into a specific sequence, or neither. The data, found in the left
side of the Group By section and Order By section, comes from the selections made in
the Columns tab.



Note – Data changes cannot be made via editable query fields if the editable query
contains Group By clauses and if the query is either Query or Report report type.
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Step
Group By Section
Step 1

In the left column, select the field to Group By.

Step 2

To move the selected field to the right column, use the Move Right arrow

Step 3

To arrange the fields, use the Move Up arrow

Step 4

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.
.

.

Order By Section
Step 5

In the left column, select the field to Order By.

Step 6

To move a selected field to the right column, you can use the Ascending arrow
ascending sort or the Descending arrow

for an

for a descending sort.

Step 7

To arrange the fields, use the Move Up arrow

Step 8

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.

.

Summary Columns Section
Step 9

If a Sum applies to your report, select a field to sum by checking the box in the SUM
column.
Any Sum fields will have a subtotal at each Group By level. When displayed to a user, a
report containing a Summary (total) row ignores the value of the Result Size property.

Step 10 Click Save.
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Filters Tab
The Filters tab uses fields, operators, and values to focus the results to display. The
information in the Filters tab is organized into four sections:
•
•
•
•

The Business Object section on the upper left indicates the source business objects.
The Columns section on the lower left identifies which fields in the selected business object to use
as filters.
The User Filter Columns and System Filter Columns sections specify filters, so that only records
with fields that contain values that meet the specified criteria are included in a report.
For additional filtering, you can use the Advanced tab to filter records based on their association
with other records.

The selected filters are executed sequentially, from top to bottom. Plan the sequence
ahead of time. Reports run faster if the filter that filters out the most records is
specified first, followed by the one that filters out the next highest number of
records, and so on.
Step
Business Object Section
The business objects listed in the Business Object section are from the Business Objects sub-tab
in the My Report tab.
Step 1

Select the Business Object.

Columns Section
The fields displayed in the Columns section come from the selected business object.
The columns in the Columns section are:
User: The filter value will be specified at runtime by the user. A user filter has no impact on the
total results that the user sees.
System: The filter value limits the total results that the user sees. A system filter is applied by
the system each time a report executes.
Field Label: The label for the field.
Field Name: The system name for the field.
Step 2

For each field used as a filter, select the check box in either or both the User or System
column. The system adds the selected fields to the User Filter Columns section and the
System Filter Columns section.
When you select a different business object, the fields displayed in the Columns section
change, but previously selected fields in the User Filter Columns section and System
Filter Columns section remain.
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Step
User Filter Columns Section and System Filter Columns Section
When you select a User check box in the Columns section, the field appears in the list in the User
Filter Columns section.
When you select a System check box in the Columns section, the field appears in the list in the
System Filter Columns section.
Clearing a check box in the Columns section removes the field from the corresponding filter
columns list.
The Field column shows the field’s label and system name.
To see the source of a field, hover your mouse over the hyperlink in the Field column.
The system applies filters sequentially from top to bottom in the list.
Step 1

To change the sequence in which the filters apply, select a field and click Move up,
Move down, Move to top, or Move to bottom. Organize filters so that the filters that
eliminate the most records are listed first.

Step 2

To change the label that displays for a filter, edit the text in the Report Label text box.
The report labels only apply if runtime filters are used, and then only if the field is not
already displayed, or if the filter is a second runtime filter against the same field.
If the field is a Time field, the user must input the time in milliseconds or as a string in
hh:mm:ss format.

Step 3

From the Filter Operator drop-down box, select the comparison filter operator.
The choices presented depend on the field type of the selected field.
For more information about the available operators, see Appendix A: Filter Operators.

Step 4

For system filters that the user provides a value for at runtime, specify the Value that
must be matched. To filter a Boolean field, use the values TRUE or FALSE.
For more information about the special values, see Appendix B: Special Values.

Step 5

To organize system filters in sets to further refine the order in with the filters are
applied, select the Join Operator.
The join operator provides one layer of grouping. For the first field, the choices are
blank and NOT. For subsequent fields, the choices are AND, OR, AND NOT, and OR NOT.
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Step
Another layer of system filter grouping comes from the column to the right of the Join
Operator column and the column to the right of the Value column. Together they provide
the ability to define sets of filters. The filters in each group are applied as a unit before
joining their result with the rest of the filters.
You can organize groups within groups. The innermost group will be applied first, all the
way up to the outermost group.
Step 6

To organize nested filters, use the selections in the numbered drop-down.

Step 7

Click Save.
If your filter groups are uneven, the system displays an error message and does not apply
your changes. See the example in Appendix D: Example of User Filters and System
Filters.

Step 8

To copy an existing filter and create one with the same source, select the filter item and
click Copy.
A new identical row appears below the copied row. The copy of a User filter appears in
the User Filter Columns section. The copy of a System filter appears in the System Filter
Columns section. The system clears any groupings in the System Filter Columns section.

Step 9

Adjust the values in the filter properties, as described above.

Step 10 To remove a row, select the row and click Remove.
If you click Remove and this is the only row that refers to a field in the Columns section,
the system clears the field’s check box in the Columns section.
If you clear the check box in the Columns section, the system removes all rows in both
filter columns sections that refer to that field.
Step 11 Click Save.
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Advanced Tab
Using the Advanced tab, you can filter records based on their association with other
records. For additional filtering, use the Filters tab to target the search results
displayed using fields, operators, and values.
Step
Association Filters Section
Step 1

On the Association Filters section bar, click Add.
You can define the type of associated records by which you want to filter the results of
the report.
To avoid potential report performance issues, avoid using –Any- for the module
selection and All for the business object selection whenever possible.

Step 2

Select the Module.

Step 3

Select the Business Object. To include all business objects in the selected module, select
All.
The choices in Business Object depend on the selected module.

Step 4

Select the Association Type.
This is the association type defined from the perspective of the filtering module and
business object specified immediately above. To include all association types, select
ALL.

Step 5

All new reports will have aReverse Association set toNo. If an existing report has a
Reverse Association set to Yes, a warning message will display. If a report used in the
association filter down the line has a Reverse Association set to Yes, a warning message
will display. To remove the warning message, set the Reverse Association to No.
It is no longer possible to set the Reverse AssociationFlag. Only existing reports with the
flag set will be able to show the flag in the association filter. When the Reverse
Association is set to No, it is not possible to set it back to Yes.

Step 6

To specify which records to use to filter the result set of the report or query for which
the association filter is defined, use the Filter Type and Record / Query fields.
You can specify a specific filtering record through the use of special name values. You
can specify multiple filtering records by specifying Query in the Filter Type field and
then selecting a query that returns the filtering records in the Record / Query field. For
more information about both of these fields, see Appendix C: Special Names in Record
Field, and the Application Building for the IBM TRIRIGA Application Platform 3 book.

Step 7

Click OK.
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Step
Step 8

To delete an association filter, select the check box, and click Delete.

Step 9

Click Save.

My Report: Summary Report
When a report record’s type is Summary, the result is a tabular report showing totals
from the values in records.

My Report Tab
Define the report and its scope in the My Report tab of the report record.
Step
Specify identifying information about the report.
Step 1

Specify the Nameof the report.
Names must be unique. Use the naming conventions described in the Naming Conventions
section in this user guide.

Step 2

Specify the IDto further identify the report. Use CUSTOM or your company’s numbering
standards for reports.

Step 3

Specify the Header (Title). This is the text that shows at the top of the report.

Step 4

To use an additional grouping for filtering, specify the Tag.

Step 5

Specify a complete Descriptionof the report.

Step 6

Type indicates what sort of report this record is. Standard choices are Report,
Graphic, Chart, Summary, Hierarchy, and Metric.
The fields that display in this tab and the other tabs in this record vary, based on your
selection for Type.

Step 7

Select Summary.
The Business Objects, Options, Related Reports, and Security sub-tabs provide more
particulars about the report.

© Copyright IBM Corporation 2011, 2015.

22

Business Objects Sub-Tab
The Business Objects sub-tab identifies the data available to this report record.
Step
Step 1

In the Business Objects sub-tab, select Add Business Object.

Step 2

From the drop-down box, select the Module.
The system displays the business objects in the selected module.
The Business Object specifies whether the report works with data from any business
object in the module or if it works with data from specific business objects.

Step 3

Select the Business Objects.
The list contains –All- and the names of the business objects in the specified module.
If you select –All-, the report works with any data from any business object in the
specified module.
If you select the name of one or more business objects, the report works only with data
from the specified business objects.
To select multiple business objects, hold the Ctrl or Shift key and click your selections. If
you select multiple business objects, you only can select fields from the base business
object.

Step 4

Select the Forms.
If you select –All-, the data included in the report will not be filtered by form. If you
select the name of one or more forms, only data associated with the specified forms are
included in the report. To select multiple forms, hold the Ctrl or Shift key and click your
selections.

Step 5

Click OK.

Step 6

Click Save.
The Run Report action becomes available. Use Run Report any time you want to test
your report design.
The Edit and Remove actions become available to manage the list in the Business
Objects sub-tab.

Step 7

To edit a business object line item, either click the hyperlink or select the radio button
and click Edit.
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Step
Step 8

Optional: Select other business objects.

Step 9

Click Add Business Object.
To add a child business object, select the parent business object before clicking Add
Business Object.

Step 10 Select the Module for the report.
Step 11 From the Business Object list, select from the business object.
To select multiple business objects, hold the Ctrl or Shift key and click your selections.
Step 12 Select Associated Options.
To select multiple associated options, hold the Ctrl or Shift key and click your selections.
Step 13 Optional: Deselect Show only Associations defined in Data Modeler.
This check box is selected by default to help limit the number of associations that appear
in drop-down boxes. If deselected, the form displays all modules, all business objects
relative to the selected module, and all association types in the system.
Step 14 To designate this object as the Primary Associated Business Object, select the box.
The Primary Associated Business Object check box displays only for direct descendants,
i.e., child associations. By default, it is selected for the first child business object added.
If you remove the designated primary associated business object, the system designates
the next associated business object in the tree as the primary associated business
object.
Step 15 Click OK.
The new object appears in the Business Objects sub-tab under the selected parent
business object. Indentation identifies parent business objects and their children.
When an associated business object is the Primary Associated Business Object, it is
denoted by a purple square after the module name in the Module column.
The Remove action does not apply to the primary business object. To change the
primary business object, edit its properties.
To remove a non-primary business object, select the Business Object and click Remove.
If you remove an associated business object, you cannot use the fields from that business
object for the report.
If you remove a business object that is part of a hierarchical list, the system also
removes its children.
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Step
Step 16 Click Save.

Options Sub-Tab
The Options sub-tab contains elements that are unique to the Summary report type.
Step
When the report type is Summary, the Options sub-tab presents the following options.
The Data Scope limits the data that are accessible to the report.
Step 1

Select a value for Data Scope. The default value is Active Project.

Value

Description

Active
Project

The data available to the report is restricted to the active project. If the parent
record is a capital project, the active project is the record itself. If the parent
record is not a capital project, the active project is the project in which the
parent record resides.

Company

Only data that exists outside a project is accessible to the report.

All
Projects

The report includes all data, without regard to project or company.

The data displayed in a report can be formatted as a Microsoft Excel spreadsheet by
applying an Excel template retrieved from the Document Manager.
Step 2

To specify an Excel Template, click the Search icon

.

You can use the Name field to search for Excel templates that start with the text you
specify. Use the % character in the Name field as a wild card to widen your search to any
word in the name. For example, type %security to find a template with the word
security anywhere in the name.
Step 3

Select the Excel template and click Accept.
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Step
Step 4

To enable the user to specify runtime filters to set initial criteria before the report
executes, select Prompt Before Query.
When the Prompt Before Query check box is deselected, the report executes
immediately when the user selects it. SelectPrompt Before Query for all
performance-intensive reports.

Step 5

For Editable, select Yes or No.
Editable determines whether a user can edit the values in the records displayed in the
report directly from the report.

Step 6

Click Save.

Related Reports Sub-Tab
A related report is a self-contained report that has its own definition and format. Its
usual purpose is to display additional information the viewer might find relevant. A
main report can have more than one related report. A related report cannot have
another related report. Values can be passed between a main report and a related
report using shared variables. Generally a related report contains a reference back to
the main report. Specify any related reports in the Related Reports sub-tab.
Step
When the report type is Summary, the Related Reports sub-tab presents the following options.
Step 1

To add a related report, select Add.

Step 2

On the section bar, click the Filter icon

Step 3

To restrict the reports displayed to only one report type, select a report type.

.

The default is Report. To see all types of reports, select All.
The report types are explained elsewhere in this chapter.
Step 4

Select the Module. The drop-down box contains only modules for which you have security
access.
The system displays My Reports and Community reports (designated by the C) matching
the selected report type and module.
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Step
Step 5

Select the check boxes of the related reports.

Step 6

Click OK.
When available, clicking a hyperlink opens the definition of that report.
Related reports appear in the presentation in the same sequence as they appear in the
Related Reports sub-tab, from top to bottom.

Step 7

To change the sequence, click the arrows in the Order column to move a related report
up or down in the list.

Step 8

Click Save Order.

Step 9

To delete a related report, select the report and click Remove.

Step 10 Click Save.

Security Sub-Tab
The Security sub-tab names groups that can access this report.
Step
When the report type is Summary, the Security sub-tab presents the following options.
Although not shown in the Security sub-tab, the system automatically adds the user creating the
report to the Security Access section. The owner has full access privileges.
Use the Add action on the Security Access section bar to grant access to groups.
Step 1

Click Add.

Step 2

Select the check boxes of the groups to have access to the report.

Step 3

Click Accept.
By default, every group listed has View access.

Step 4

To grant additional access to a group, select the check box next to one or more of the
following: All, Edit, Delete, Copy, Share.

Step 5

To delete a group, select the check box and click Remove.

Step 6

Click Save.
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Columns Tab
The Columns tab defines which fields to use in the report. The information in the
Columns tab is organized into three sections:
•
•
•

The Business Object section on the upper left indicates the source business objects.
The Columns section on the lower left identifies which fields in the selected business object to
include in the report.
The Display Columns section on the right specifies the order in which the selected fields are
presented and the labels used to identify them.
Step
Business Object Section
Step 1

Select the Business Object. The fields in the selected business object display in the
Columns section.
The business objects listed in the Business Object section are from the Business Objects
sub-tab in the My Report tab.

Columns Section
The fields displayed in the Columns section come from the selected business object.
Step 2

Select the check box for each field to include in the report. The system adds the
selected fields to the Display Columns section.
The fields displayed in the Columns section come from the selected business object.
When you select a different business object, the fields displayed in the Columns section
change but previously selected fields in the Display Columns section remain.

Display Columns Section
When you select a check box in the Columns section, the field appears in the list in the Display
Columns section.
Clearing a check box in the Columns section removes the field from the Display Columns list.
The Field column shows the field’s label and system name.
Step 3

To change the sequence in which the fields display, select the field and click Move up,
Move down, Move to top, or Move to bottom until the field list is ordered the way you
want.

Step 4

To change the label that displays for a field, edit the text in the Report Labeltext box.

Step 5

To specify a percentage of the display space for a field, specify a numerical value in the
Width text box.
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Step
Step 6

To remove a field, select the field and click Remove.

Step 7

Click Save.

Order & Group Tab
The Order & Group tab defines the layout of the data in the report. You can organize
the layout by group, into a specific sequence, or neither. The data, found in the left
side of the Group By section and Order By section, comes from the selections made in
the Columns tab.

Step
Group By Section
Step 1

In the left column, select the field to Group By.

Step 2

To move the selected field to the right column, use the Move Right arrow

Step 3

To arrange the fields, use the Move Up arrow

Step 4

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.
.

.

Order By Section
Step 5

In the left column, select the field to Order By.

Step 6

To move a selected field to the right column, you can use the Ascending arrow
ascending sort or the Descending arrow

for an

for a descending sort.

Step 7

To arrange the fields, use the Move Up arrow

Step 8

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.

.
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Step
Summary Columns Section
Step 9

If a Sum applies to your report, select a field to be summed by checking the box in the
SUM column.
Any Sum fields will have a subtotal at each Group By level. When displayed to a user, a
report containing a Summary (total) row ignores the value of the Result Size property.

Step 10 Click Save.

Filters Tab
The Filters tab uses fields, operators, and values to focus the results to display. The
information in the Filters tab is organized into four sections:
•
•
•
•

The Business Object section on the upper left indicates the source business objects.
The Columns section on the lower left identifies which fields in the selected business object to use
as filters.
The User Filter Columns and System Filter Columns sections specify filters, so that only records
with fields that contain values that meet the specified criteria are included in a report.
For additional filtering, you can use the Advanced tab to filter records based on their association
with other records.

The selected filters are executed sequentially, from top to bottom. Plan the sequence
ahead of time. Reports run faster if the filter that filters out the most records is
specified first, followed by the one that filters out the next highest number of
records, and so on.
Step
Business Object Section
The business objects listed in the Business Object section are from the Business Objects sub-tab
in the My Report tab.
Step 1

Select the Business Object.
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Step
Columns Section
The fields displayed in the Columns section come from the selected business object.
The columns in the Columns section are:
User: The filter value will be specified at runtime by the user. A user filter has no impact on the
total results that the user sees.
System: The filter value limits the total results that the user sees. A system filter is applied by
the system each time a report executes.
Field Label: The label for the field.
Field Name: The system name for the field.
Step 2

For each field used as a filter, select the check box in either or both the User or System
column. The system adds the selected fields to the User Filter Columns section and the
System Filter Columns section.
When you select a different business object, the fields displayed in the Columns section
change but previously selected fields in the User Filter Columns section and System Filter
Columns section remain.

User Filter Columns Section and System Filter Columns Section
When you select a User check box in the Columns section, the field appears in the list in the User
Filter Columns section.
When you select a System check box in the Columns section, the field appears in the list in the
System Filter Columns section.
Clearing a check box in the Columns section removes the field from the corresponding filter
columns list.
The Field column shows the field’s label and system name.
To see the source of a field, hover your mouse over the hyperlink in the Field column.
The system applies filters sequentially from top to bottom in the list.
Step 3

To change the sequence in which the filters will apply, select a field and click Move up,
Move down, Move to top, or Move to bottom until each filter is ordered the way you
want. Organize filters so that the filters that eliminate the most records are listed first.
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Step
Step 4

To change the label that displays for a filter, edit the text in the Report Label text box.
The report labels only apply if runtime filters are used, and then only if the field is not
already displayed, or if the filter is a second runtime filter against the same field.
If the field is a Time field, the user must input the time in milliseconds or as a string in
hh:mm:ss format.

Step 5

From the Filter Operator drop-down box, select the comparison filter operator.
The choices presented depend on the field type of the selected field.
For more information about the available operators, see Appendix A: Filter Operators.

Step 6

For system filters that the user provides a value for at runtime, specify the Value that
must be matched. To filter a Boolean field, use the values TRUE or FALSE.
For more information about the special values, see Appendix B: Special Values.

Step 7

To organize system filters in sets to further refine the order in with the filters are
applied, select the Join Operator.
The join operator provides one layer of grouping. For the first field, the choices are
blank and NOT. For subsequent fields, the choices are AND, OR, AND NOT, and OR NOT.

Another layer of system filter grouping comes from the column to the right of the Join Operator
column and the column to the right of the Value column. Together they provide the ability to
define sets of filters. The filters in each group are applied as a unit before joining their result
with the rest of the filters.
You can organize groups within groups. The innermost group will be applied first, all the way up
to the outermost group.
Step 8

To organize nested filters use the selections in the numbered drop-down.

Step 9

Click Save.
If your filter groups are uneven, the system displays an error message and does not apply
your changes. See the example in Appendix D: Example of User Filters and System
Filters.

Step 10 To copy an existing filter and create one with the same source, select the filter item and
click Copy.
A new identical row appears below the copied row. The copy of a User filter appears in
the User Filter Columns section. The copy of a System filter appears in the System Filter
Columns section. The system clears any groupings in the System Filter Columns section.
Step 11 Adjust the values in the filter properties, as described above.
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Step
Step 12 To remove a row, select the row and click Remove.
If you click Remove and this is the only row that refers to a field in the Columns section,
the system clears the check box in the Columns section.
If you clear the check box in the Columns section, the system removes all rows in both
filter columns sections that refer to that field.
Step 13 Click Save.

Advanced Tab
Using the Advanced tab, you can filter records based on their association with other
records. For additional filtering, use the Filters tab to target the search results
displayed using fields, operators, and values.
Step
Association Filters Section
Step 1

On the Association Filters section bar, click Add.
You can define the type of associated records by which you want to filter the results of
the report.
To avoid potential report performance issues, avoid using –Any- for the module
selection and All for the business object selection whenever possible.

Step 2

Select the Module.
The choices in Business Object depend on the selected module.

Step 3

Select the Business Object. To include all business objects in the selected module, select
All.
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Step
Step 4

Select the Association Type.
This is the association type defined from the perspective of the filtering module and
business object specified immediately above. To include all association types, select
ALL.

Step 5

All new reports will have aReverse Association set toNo. If an existing report has a
Reverse Association set to Yes, a warning message will display. If a report used in the
association filter down the line has a Reverse Association set to Yes, a warning message
will display. To remove the warning message, set the Reverse Association to No.
It is no longer possible to set the Reverse AssociationFlag. Only existing reports with the
flag set will be able to show the flag in the association filter. When the Reverse
Association is set to No, it is not possible to set it back to Yes.

Step 6

To specify which records to use to filter the result set of the report or query for which
the association filter is defined, use the Filter Type and Record / Query fields.
You can specify a specific filtering record through the use of special name values. You
can specify multiple filtering records by choosing Query in the Filter Type field and then
choosing a query that returns the filtering records in the Record / Query field. For more
information about both of these fields, see Appendix C: Special Names in Record Field,
and the Application Building for the IBM TRIRIGA Application Platform 3 book.

Step 7

Click OK.

Step 8

To delete an association filter, select the check box, and click Delete.

Step 9

Click Save.

My Report: Metric Report
When a report record’s type is Metric, the result presents aggregated data in a table
or chart.
You can set up a metric graphic report to drill through to the underlying data when
the user clicks on a specific data point of the report. You do this by creating a metric
tabular report that represents the underlying records, and associating the metric
tabular report with the target metric graphic report, as described in the My Report:
Metric Report - Drill-Through section.
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My Report Tab
Define the report and its scope in the My Report tab of the report record.
Step
Complete identifying information about the report.
Step 1

Specify the Nameof the report.
Names must be unique. Use the naming conventions described in the Naming Conventions
section in this user guide.

Step 2

Specify the IDto further identify the report. Use CUSTOM or your company’s numbering
standards for reports.

Step 3

Specify the Header (Title). This is the text that shows at the top of the report.

Step 4

To use an additional grouping for filtering, specify the Tag.

Step 5

Specify a complete Descriptionof the report.

Step 6

In the Type field, select Metric.

Step 7

In the Data Scope field, select Active Project.

The Business Objects, Options, Related Reports, and Security sub-tabs provide more particulars
about the report.

Business Objects Sub-Tab
The Business Objects sub-tab identifies the data available to this report record.
Step
Step 1

In the Business Objects sub-tab, select Add Business Object.

Step 2

Select the Module.
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Step
Step 3

Select the Business Objects.
If you select –All-, the report works with any data from any business object in the
specified module.
If you select the name of one or more business objects, the report only works with data
from the specified business objects.
To select multiple business objects, hold the Ctrl or Shift key and click your selections. If
you select multiple business objects, you can only select fields from the base business
object.

Step 4

Select the Forms.
If you select –All-, the data included in the report will not be filtered by form. If you
select the name of one or more forms, only data associated with the specified forms are
included in the report. To select multiple forms, hold the Ctrl or Shift key and click your
selections.

Step 5

Click OK.

Step 6

Click Save.
The Run Report action becomes available. Use Run Report any time you want to test your
report design.
The Edit and Remove actions become available to manage the list in the Business Objects
sub-tab.

Step 7

To edit a business object line item, either click the hyperlinked name or select the radio
button and click Edit.

Step 8

Click Save.

Options Sub-Tab
The Options sub-tab contains elements that are unique to the Metric report type.
Step
When the report type is Metric, the Options sub-tab presents the following options.
Step 1

ForGraph Y Title, specify the text to use as the title for the Y-axis of the chart.
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Step
Step 2

To display the legend on the chart, select Display Legend.
By default, Display Legend is deselected, which optimizes the chart viewing area.
Charts honor the Display Legend value except when maximized. When maximized, the
legend always displays.
For charts that display in a small area, leave the Display Legend property deselected.

Step 3

Optional: Specify a value for Precision.
Precision specifies the number of decimal places to display in the chart and in the chart
hover information. Precision must be greater than or equal to 0 and less than 13.

Step 4

Optional: Select Tabular Output.
When Tabular Output is selected, the metric chart displays as a tabular report instead of
as a chart.
By default, Tabular Output is deselected.

Threshold / Scorecard Settings Section
Thresholds identify how to score metric values. Each threshold record contains values, ranges,
and colors. A threshold record can support either three ranges (for example, low, medium, and
high) or two ranges (for example, low and high).
In metric charts based on Fact Tables, the threshold record defines the ranges and the count of
values that fall within each range. In metric charts not based on Fact Tables, the threshold record
sets the color used in the chart.
Find Threshold definitions in the Tools menu item on the first level of the menu bar. Select
Tools > System Setup > General > Thresholds. For more information, go to the IBM TRIRIGA 10
Knowledge Center and select Administering IBM TRIRIGA>Reporting>Thresholds.
Step 5

Click the Search icon

Step 6

Select the Scorecard Category.

and select the Threshold Record.

Scorecard categories organize metrics into groups for display.
Step 7

To indicate whether the target of the metric chart is a low value or a high value, select
Low Threshold or High Threshold.
The Scorecard Target Value can be based on any value that is set in the selected
threshold record.

Step 8

Click Save.
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Related Reports Sub-Tab
A related report is a self-contained report that has its own definition and format. The
typical purpose is to display additional information the viewer might find relevant. A
main report can have more than one related report. A related report cannot have
another related report. Values can be passed between a main report and a related
report using shared variables. Generally, a related report contains a reference back to
the main report. Specify any related reports in the Related Reports sub-tab.
Step
When the report type is Metric, the Related Reports sub-tab presents the following options.
Step 1

To add a related report, select Add.

Step 2

Click the Filter icon
that report type.

and select a report type to restrict the reports displayed to only

The default is Report. To see all types of reports, select All.
The report types are explained elsewhere in this chapter.
Step 3

Select the Module.
The drop-down list contains only those modules for which you have security access.
The system displays My Reports and Community reports (designated by the C) matching
the elected report type and module.

Step 4

Select the check boxes of the related reports.

Step 5

Click OK.
When available, clicking a hyperlink opens the definition of that report.

Step 6

To make the filters defined in the related report available at runtime, select the Apply
Filters.

Step 7

To change the sequence of the related reports, click the arrows in the Order column and
move a related report up or down in the list.
Related reports appear in the presentation in the same sequence as they appear in the
Related Reports sub-tab, from top to bottom.

Step 8

Click Save Order.

Step 9

To delete a related report, select the check box and click Remove.
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Step
Step 10 Click Save.

Security Sub-Tab
The Security sub-tab names the groups that can access this report.
Step
When the report type is Metric, the Security sub-tab presents the following options.
Although not shown in the Security sub-tab, the system automatically adds the user who creates
the report to the Security Access section. The owner has full access privileges.
To grant access to groups, use the Add action on the Security Access section bar.
Step 1

Click Add.

Step 2

Select the check boxes of the groups to have access to the report.

Step 3

Click Accept.
By default, every group listed has View access.

Step 4

To grant additional access to a group, select All, Edit, Delete, Copy, or Share.

Step 5

To delete a group, select the check box and click Remove.

Step 6

Click Save.

Columns Tab
The Columns tab specifies how to aggregate data for this report.
Step
Aggregation Settings Section
Step 1

On the Aggregation Settings section bar, click Add.

Step 2

Specify a Label for the report display.
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Step
Step 3

Select a Function.

Step 4

Specify a Sequence number.
Sequence identifies the order in which to apply the aggregation setting when the metric
report runs.

Step 5

To specify the field upon which the aggregation occurs, select Field1.

Step 6

For Target Axis, select either Primary Y-Axis or Secondary Y-Axis.
Target Axis identifies where the aggregated data displays.
Use Secondary Y-Axis to display a second data series with the primary one.

Step 7

To specify a Color to represent this aggregation, click the Search icon

.

The system offers Basic and Advanced palettes from which to select the Color. When
Color is blank, the system uses the color from the user’s My Profile record. The default
color is blank.
Step 8

Click OK.

Step 9

Optional: Add additional aggregation settings.

Step 10 To delete an aggregation setting, select the check box and click Delete.
Step 11 Click Save.

Order & Group Tab
The Order & Group tab defines the layout of the data in the metric. The information
in the Order & Group tab is organized into three sections:
•
•
•

The Group By section defines the fields that appear in the Group By area of the metric report and
the graph type.
The Secondary Group By Properties section provides a second level of group by.
The Order By section specifies the fields by which to sort the data.
Step
When the report type is Metric, the Order & Group tab presents the following options.
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Step
Group By Section
To add a group by, use the Add action on the Group By section bar. You can add more than one
Group By.
Step 1

Click Add.

Step 2

Specify the field to group by.
The system pre-populates Label from the Field definition.

Step 3

Specify the Label for the report.

Step 4

Optional: If a field is hierarchical, and you want it to have hierarchical support:


From the drop-down box, select Hierarchy Definition.



To specify a Root, click the Search icon

and select from the choices.

To treat the hierarchical field as a regular text field, do not use these options.
Step 5

If the field you specified is a Date or DateTime field, in the Group Dates By field, select
a date format to group by.
The group by date selection works on both fact and transactional tables, but only for
metric reports.
When grouping in Calendar Hour, Calendar Day, Calendar Week, Calendar Month, or
Calendar Year, the system uses the date or date-time function in the database.
When grouping in Calendar Quarter, the system uses the start and end date defined in
Calendar Period Classification records as the ranges, and uses the name value in those
classification records as the display label of the group.
When grouping in Fiscal Month, Fiscal Quarter, or Fiscal Year, the system uses the start
and end date defined in Fiscal Periods Classification records as the ranges, and uses the
name value in those classification records as the display label of the group.
If the user profile does not have a defined date format, the system date format defined
in the property file is used.

Step 6

Select the Chart Type.
Chart Type identifies the type of display.
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Step
Step 7

Select the Chart Template.
Chart Template specifies the chart within the chart type.
Find Chart Template definitions in the Tools menu item on the first level of the menu
bar. Select Tools > System Setup > General > Chart Templates. For more information,
go to the IBM TRIRIGA 10 Knowledge Center and select Administering IBM
TRIRIGA>Reporting>Creating chart templates.
The system displays a miniature image that represents the chart type and chart
template.

The remaining fields in the Group By Properties form depend on the selected Chart Template.
When the Chart Type is Bar, the standard choices for Chart Template are: Horizontal
Grouped Bar, Horizontal Stacked Bar, Vertical Grouped Bar, and Vertical
Stacked Bar.
When the Chart Type is Bar (Percent), the standard choices for Chart Template are:
Horizontal Grouped Bar (percent) and Vertical Grouped Bar (percent).
When the Chart Type is Line, the standard choices for Chart Template are: Line and Spline.
When the Chart Type is Pie, the standard choices for Chart Template are: 3D Doughnut, 3D
Pie, Doughnut, and Pie.
When the Chart Type is Circular Gauge, the standard choices for Chart Template are:
Circular Bar Gauge and Circular Gauge.
When the Chart Type is Linear Gauge, the standard choices for Chart Template are: Horizontal
Linear Bar Gauge, Horizontal Linear Tank Gauge, Vertical Linear Bar Gauge, and Vertical Linear
Tank Gauge.
When the Chart Type is Circular Gauge (Percent), the standard choices for Chart Template
are: Circular Bar Gauge (percent) and Circular Gauge (Percent).
When the Chart Type is Linear Gauge (Percent), the standard choices for Chart Template are:
Horizontal Linear Bar Gauge (percent), Horizontal Linear Tank Gauge (percent), Vertical Linear
Bar Gauge (percent), and Vertical Linear Tank Gauge (percent).
When the Chart Type is Bubble, the standard choice for Chart Template is: Bubble.
When the Chart Type is Pyramid, the standard choice for Chart Template is: Pyramid.
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Step
When the Chart Type is Line-Bar Combo, the standard choices for Chart Template are: Line /
Vertical Grouped Bar Combo and Line / Vertical Stacked Bar Combo.
Using a Bubble chart for purposes of illustration:
Step 8

If specified, the Secondary Data Source displays in the same chart as the primary data
source. Click the Search icon

to select.

The secondary data source displays in the same chart as the primary data source for
Bar, Line, and Bubble charts. For Gauge charts, the secondary data source displays as
a separate gauge next to the primary gauge. For Line-Bar Combo charts, the
secondary data source can be a different chart type than the primary data source.
Step 9

Click OK.

Step 10 Optional: Repeat steps 1 – 9 to add additional Group By properties.
Step 11 When there is more than one group by, specify the Default by selecting the appropriate
radio button.
Step 12 To change the sequence, click the arrows in the Order column to move a group by up or
down in the list.
The group bys appear in the presentation in the same sequence as they appear in the
Group By section, from top to bottom.
Step 13 Click Apply Order.
Step 14 To delete a group by, select the check box and click Delete.

Secondary Group By Properties Section
You can use the Secondary Group By section to group by a column, which results in a
multi-series chart with one aggregation. When you define a Secondary Group By, and you define
more than one aggregation in the Group By section, the system ignores the secondary group.
Step 1

Specify the Field.

Step 2

Specify the Label.

Step 3

Select the Hierarchy Definition.

Step 4

To specify a Root, click the Search icon
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Step
Order By Section
Step 1

Optional: In the left column, select the field to Order By.

Step 2

Use the Ascending arrow
descending sort.

Step 3

Use the Move Up arrow

Step 4

Use the Move Left arrow
column.

Step 5

Click Save.

for an ascending sort or the Descending arrow
and Move Down arrow

for a

to arrange the fields.

to return the selection from the right column to the left

Filters Tab
The Filters tab uses fields, operators, and values to focus the results to display. The
selected filters are executed sequentially from top to bottom. Plan the sequence
ahead of time. Reports run faster if the filter that filters out the most records is
specified first, followed by the one that filters out the next highest number of
records, and so on.
Step
When the report type is Metric, the entries in the Filter section define the filters applied at
runtime.
Step 1

Click Add.

Step 2

Select the Field to use as the filter.
The system displays fields in SectionName::FieldName format.

Step 3

Optional: Change the Label for the report.
The system pre-populates Label from the Field definition.

Step 4

Optional: Select Hierarchy Definition from the drop-down box.
This option is available only when the field is hierarchical.

Step 5

Optional: To specify a Root, click the Search icon

and select from the choices.

This option is available only when the field is hierarchical.
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Step
Step 6

Select the comparison filter operator.
The choices presented in the Operator drop-down box depend on the field type of the
selected Field. For more information about the available operators, see Appendix A:
Filter Operators.

Step 7

Select or deselect the Conditional check box.
If you select the check box, the system filter is ignored in the query results when the
filter input is empty.

Step 8

Specify the Value.
The user can specify the filter value at runtime. For more information about the special
values, see Appendix B: Special Values.

Step 9

Click OK.

Step 10 To change the sequence, click the arrows in the Order column to move a filter up or
down in the list.
The system applies filters sequentially from top to bottom of the list.
Step 11 Click Apply Order.
Step 12 To delete a filter, select the check box and click Delete.
Step 13 Click Save.

Advanced Tab
Using the Advanced tab, you can filter records based on their association with other
records. For additional filtering, use the Filters tab to target the search results
displayed using fields, operators, and values.
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Step
Association Filters Section
Step 1

On the Association Filters section bar, click Add.
You can define the type of associated records by which to filter the results of the report.
To avoid potential report performance issues, avoid using –Any- in the module selection
and All for the business object selection whenever possible.

Step 2

Select the Module. To include all modules, select –Any-.

Step 3

Select the Business Object. To include all business objects in the selected module, select
All.
The choices in Business Object depend on the selected module.

Step 4

Select the Association Type.
This is the association type defined from the perspective of the filtering module and
business object specified immediately above. To include all association types, select
ALL.

Step 5

All new reports will have aReverse Association set toNo. If an existing report has a
Reverse Association set to Yes, a warning message will display. If a report used in the
association filter down the line has a Reverse Association set to Yes, a warning message
will display. To remove the warning message, set the Reverse Association to No.
It is no longer possible to set the Reverse AssociationFlag. Only existing reports with the
flag set will be able to show the flag in the association filter. When the Reverse
Association is set to No, it is not possible to set it back to Yes.

Step 6

To specify which records to use to filter the result set of the report or query for which
the association filter is defined, use the Use the Filter Type and Record / Query fields.
You can specify a specific filtering record through the use of special name values. You
can specify multiple filtering records by selecting Query in the Filter Type field and
then selecting a query that returns the desired filtering records in the Record / Query
field.
For more information about both of these fields, see Appendix C: Special Names in
Record Field and the Application Building for the IBM TRIRIGA Application Platform 3
book.

Step 7

Click OK.

Step 8

Optional: To debug the construction of your metric report, use the Validate action.

Step 9

To delete an association filter, select the check box and click Delete.
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Step
Step 10 Click Save.

My Report: Metric Report – Drill-Through
You can set up a metric graphic report to drill through to the underlying data when
the user clicks on a specific data point of the report. You do this by creating a metric
tabular report that represents the underlying records, and associating the metric
tabular report with the target metric graphic report. This feature works for both fact
and transactional data.
The system filters the records based on which data point you pick. For example, you
might have a metric graphic report that represents the sum of the original budget by
status against the project fact table. When the user clicks on the Active status data
point in the metric graphic chart, the system displays only the underlying records with
an Active status in the tabular view. Then, the user can drill down from the tabular
chart to the base record.
Before you create the drill-through report, you must create the target metric graphic
report, as described in the My Report: Metric Report section and associate the tabular
report with it.
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My Report Tab
Define the tabular report and its scope in the My Report tab of the report record.
Step
Complete identifying information about the report.
Step 1

Specify the Nameof the report.
Names must be unique. Use the naming conventions described in the Naming Conventions
section in this user guide.

Step 2

Specify the IDto further identify the report. Use CUSTOM or your company’s numbering
standards for reports.

Step 3

Specify the Header (Title). This is the text that shows at the top of the report.

Step 4

To use an additional grouping for filtering, specify the Tag.

Step 5

Specify a complete Descriptionof the report.

Step 6

In the Type field, select Metric.

The Business Objects, Options, Related Reports, and Security sub-tabs provide more particulars
about the report.

Business Objects Sub-Tab
Step 1

In the Business Objects sub-tab, select Add Business Object.

Step 2

Select the Module that you specified in the target metric graphic report.

Step 3

Select the Business Object.
Select the name of the business object that you specified in the target metric graphic
report.

Step 4

Select the Form that you specified in the target metric graphic report.

Step 5

Click OK.
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Step 6

Click Save.
The Run Report action becomes available. Use Run Report any time you want to test your
report design.
The Edit and Remove actions become available to manage the list in the Business Objects
sub-tab.

Step 7

To edit a business object line item, either click the hyperlink or select the radio button and
click Edit.

Options Sub-Tab
The Options sub-tab contains elements that are unique to the Metric report type.
Step
When the report type is Metric, the Options sub-tab presents the following options.
Step 1

Select Tabular Output.

Step 2

If you are using a fact table, in the Associated Field, select the associated field.
Fact tables can contain aggregated data from multiple business objects. The Associated
Field tells the system which business object to display when the user wants to drill thru
to the base record. The system populates the Associated Module and Associated Business
Object fields based on the selected Associated Field.
For a transactional table, you do not need to define the Associated Field because the
primary business object is the base business object.

Security Sub-Tab
The Security sub-tab names the groups that can access this report.
Step
When the report type is Metric, the Security sub-tab presents the following options.
Although not shown in the Security sub-tab, the system automatically adds the user who creates
the report to the Security Access section. The owner has full access privileges.
To grant access to groups, use the Add action on the Security Access section bar.
Step 1

Click Add.
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Step
Step 2

Select the check boxes of the groups to have access to the report.
By default, every group listed has View access.

Step 3

Click Accept.

Step 4

To grant additional access to a group, select All, Edit, Delete, Copy, or Share.

Step 5

To delete a group, select the check box and click Remove.

Step 6

Click Save.

Columns Tab
The Columns tab specifies how to aggregate data for this report.
Step
Business Object Section
The business objects listed in the Business Object section are from the Business Objects sub-tab in
the My Report tab.
Step 1

Select the Business Object.
The fields in the selected business object display in the Columns section.

Columns Section
Step 2

Select the check box for each field to include in the report.
When you select a different business object, the fields displayed in the Columns section
change but previously selected fields in the Display Columns section remain.
Clearing a check box in the Columns section removes the field from the Display Columns
list.
The Field column shows the field’s label and system name.

Display Columns Section
Step 3

To change the sequence in which the fields display, select a field and click Move up, Move
down, Move to top, or Move to bottom.
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Step
Step 4

To change the label that displays for a field, specify the text in the Report Labeltext box.

Step 5

To specify a percentage of the display space for a field, specify a numerical value in the
Width text box.

Step 6

To remove a field, select the field and click Remove.

Step 7

Click Save.

Associate the tabular report with the target metric graphic report
After you define the tabular metric report, you need to associate it with the target metric graphic
report.
Step
Step 1

Open the target graphic metric report.

Step 2

Select the Order & Group tab.

Step 3

Add or select an existing Group By field.

Step 4

Click the Search icon

Step 5

Select the tabular metric report and click OK.

Step 6

Click Save and Close.

next to Source Tabular Report.
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My Report: Chart
When a report record’s type is Chart, the result displays records in a pie, bar, line,
or stacked bar chart. You can view the source data for the chart report by clicking
anywhere on the chart.

My Report Tab
Define the report and its scope in the My Report tab of the report record.
Step
Define identifying information about the chart.
Step 1

Specify the Nameof the report.
Names must be unique. Use the naming conventions described in the Naming Conventions
section in this user guide.

Step 2

Specify the IDto further identify the report. Use CUSTOM or your company’s numbering
standards for reports.

Step 3

Specify the Header (Title). This is the text that shows at the top of the report.

Step 4

To use an additional grouping for filtering, specify the Tag.

Step 5

Specify a complete Descriptionof the report.

Step 6

In the Type field, select Chart.

The Business Objects, Options, Related Reports, and Security sub-tabs provide more particulars
about the report.

Business Objects Sub-Tab
The Business Objects sub-tab identifies the data available to this report record.
Step
Step 1

In the Business Objects sub-tab, select Add Business Object.

Step 2

Select the Module.
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Step
The system displays the business objects in the selected module.
The Business Object specifies whether the chart works with data from any business object in the
module or if it will be constrained to work with data from specific business objects.
Step 3

Select the Business Objects.
If you select –All-, the report works with any data from any business object in the
specified module.
If you select the name of one or more business objects, the report works only with data
from the specified business objects.
To select multiple business objects, hold the Ctrl or Shift key and click your selections. If
you select multiple business objects, you can only select fields from the base business
object.

Step 4

Select the Forms.
If you select –All-, the data included in the report will not be filtered by form. If you
select the name of one or more forms, only data associated with the specified forms are
included in the report. To select multiple forms, hold the Ctrl or Shift key and click your
selections.

Step 5

Click OK.

Step 6

Click Save.
The Run Report action becomes available. Use Run Report any time you want to test
your report design.
The Edit and Remove actions become available to manage the list in the Business
Objects sub-tab.

Step 7

To edit a business object line item, either click the hyperlink or select the radio button
and click Edit.

Step 8

Optional: Select other business objects.

Step 9

Click Add Business Object.
To add a child business object, select the parent business object before clicking Add
Business Object.
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Step
Step 10 Select the Forms.
If you select –All-, the data included in the report will not be filtered by form. If you
select the name of one or more forms, only data associated with the specified forms are
included in the report. To select multiple forms, hold the Ctrl or Shift key and click your
selections.
Step 11 Select the Module.
Step 12 From the Business Object list, select from the business object.
Step 13 To select multiple business objects, hold the Ctrl or Shift key and click your selections.
Step 14 Select Associated Options.
To select multiple associated options, hold the Ctrl or Shift key and click your selections.
Step 15 Optional: Deselect Show only Associations defined in Data Modeler.
This check box is selected by default to help limit the number of associations that appear
in drop-down boxes. If deselected, the form displays all modules, all business objects
relative to the selected module, and all association types in the system.
Step 16 To designate this object as the Primary Associated Business Object, check the box.
The Primary Associated Business Object check box displays only for direct descendants,
i.e., child associations. By default, it is selected for the first child business object added.
If you remove the designated primary associated business object, the system designates
the next associated business object in the tree as the primary associated business
object.
Step 17 Click OK.
The new object appears in the Business Objects sub-tab under the selected parent
business object. Indentation identifies parent business objects and their children.
When an associated business object is the Primary Associated Business Object, it is
denoted by a purple square after the module name in the Module column.
The Remove action does not apply to the primary business object. To change the
primary business object, edit its properties.
To remove a non-primary business object, select the business object and click Remove.
If you remove an associated business object, you cannot use the fields from that business
object for the report.
If you remove a business object that is part of a hierarchical list, the system also
removes its children.
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Step
Step 18 Click Save.

Options Sub-Tab
The Options sub-tab contains elements that are unique to the Chart report type.
Step
When the report type is Chart, the Options sub-tab presents the following options.
Step 1

Select a value for Data Scope.
The Data Scope limits the data that are accessible to the report. The default value is
Active Project.

Value

Description

Active
Project

The data available to the chart is restricted to the active project. If the
parent record is a capital project, the active project is the record itself. If
the parent record is not a capital project, the active project is the project in
which the parent record resides.

Company

Only data that exists outside a project is accessible to the chart.

All
Projects

The chart includes all data records, without regard to project or company.

Step 2

For Graph X Title, specify the text to use as the title for the X-axis of the chart.

Step 3

For Graph Y Title, specify the text to use as the title for the Y-axis of the chart.

Step 4

For Graph Type, select the type of chart: Pie, Bar, Line, or Stacked Bar.

Step 5

To display the legend on the chart, select Display Legend.
By default, Display Legend is deselected, which optimizes the chart viewing area.
Charts honor the Display Legend value except when maximized. When maximized, the
legend always displays.
For charts that display in a small area, leave the Display Legend property deselected.
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Step
Step 6

Optional: Specify a value for Precision.
Precision specifies the number of decimal places to display in the chart and in the chart
hover information. Precision must be greater than or equal to 0 and less than 13.

Step 7

To specify an Excel Template, click the Search icon

.

The data displayed in a report can be formatted as a Microsoft Excel spreadsheet by
applying an Excel template retrieved from the Document Manager.
You can use the Name field to search for Excel templates that start with the text you
specify. Use the % character in the Name field as a wild card to widen your search to any
word in the name. For example, type %security to find a template with the word
security anywhere in the name.
Step 8

Select the Excel template and click Accept.

Step 9

To enable the user to specify runtime filters to set initial criteria before the report
executes, select Prompt Before Query.
When the Prompt Before Query check box is deselected, the report executes
immediately when the user selects it. SelectPrompt Before Query for all performanceintensive reports.

Step 10 For Editable, select Yes or No.
Editable determines whether a user can edit the values in the records displayed in the
report directly from the report.
Step 11 Click Save.
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Related Reports Sub-Tab
A related report is a self-contained report that has its own definition and format. The
typical purpose is to display additional information the viewer might find relevant. A
main report can have more than one related report. A related report cannot have
another related report. Values can be passed between a main report and a related
report using shared variables. Generally, a related report contains a reference back to
the main report. Specify any related reports in the Related Reports sub-tab.
Step
When the report type is Chart, the Related Reports sub-tab presents the following options.
Step 1

To add a related report, select Add.

Step 2

On the section bar, click the Filter icon

Step 3

To restrict the reports displayed to only one report type, select a report type.

.

The default is Report. To see all types of reports, select All.
The report types are explained elsewhere in this chapter.
Step 4

Select the Module.
The drop-down box contains only modules for which you have security access.
The system displays My Reports and Community reports (designated by the C) matching
the selected report type and module.

Step 5

Select the check boxes of the related reports.

Step 6

Click OK.
When available, clicking a hyperlink opens the definition of that report.

Step 7

To change the sequence of the related reports, click the arrows in the Order column and
move a related report up or down in the list.
Related reports will appear in the presentation in the same sequence as they appear in
the Related Reports sub-tab, from top to bottom.

Step 8

Click Save Order.

Step 9

To delete a related report, select the check box and click Remove.

Step 10 Click Save.
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Step
Step 11 Select the check boxes of the related reports.
Step 12 Click OK.
When available, clicking a hyperlink opens the definition of that report.

Security Sub-Tab
The Security sub-tab names groups that can access this chart.
Step
When the report type is Chart, the Security sub-tab presents the following options.
Although not shown in the Security sub-tab, the system automatically adds the user creating the
report to the Security Access section. The owner has full access privileges.
To grant access to groups, use the Add action on the Security Access section bar.
Step 1

Click Add.

Step 2

Select the check boxes of the groups to have access to the report.

Step 3

Click Accept.
By default, every group listed has View access.

Step 4

To grant additional access to a group, select All, Edit, Delete, Copy, or Share.

Step 5

To delete a group, select the check box and click Remove.

Step 6

Click Save.
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Columns Tab
The Columns tab defines which fields to use in the report. The information in the
Columns tab is organized into three sections:
•
•
•

The Business Object section on the upper left indicates the source business objects.
The Columns section on the lower left identifies which fields in the selected business object to
include in the report.
The Display Columns section on the right specifies the order in which the selected fields are
presented and the labels used to identify them.
Step
Business Object Section
Step 1

Select the Business Object. The fields in the selected business object display in the
Columns section.
The business objects listed in the Business Object section are from the Business Objects
sub-tab in the My Report tab.

Columns Section
Step 2

Select the check box for each field to include in the report. The system adds the
selected fields to the Display Columns section.
The fields displayed in the Columns section come from the selected business object.
When you select a different business object, the fields displayed in the Columns section
change but previously selected fields in the Display Columns section remain.

Display Columns Section
When you select a check box in the Columns section, the field appears in the list in the Display
Columns section.
Clearing a check box in the Columns section removes the field from the Display Columns list.
The Field column shows the field’s label and system name.
Step 3

To change the sequence in which the fields display, select a field and click Move up,
Move down, Move to top, or Move to bottom.

Step 4

To change the label that displays for a field, edit the text in the Report Labeltext box.

Step 5

To specify a percentage of the display space for a field, specify a numerical value in the
Width text box.

Step 6

To remove a field, select the field and click Remove.

Step 7

Click Save.

© Copyright IBM Corporation 2011, 2015.

59

Order & Group Tab
The Order & Group tab defines the layout of the data in the chart. You can organize
the layout by group, into a specific sequence, or neither. The data, found in the left
side of the Group By and Order By sections, comes from the selections made in the
Columns tab.
Step
Group By Section
Step 1

In the left column, select the field to Group By.

Step 2

To move the selected field to the right column, use the Move Right arrow

Step 3

To arrange the fields, use the Move Up arrow

Step 4

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.
.

.

Order By Section
Step 5

In the left column, select the field to Order By.

Step 6

To move a selected field to the right column, you can use the Ascending arrow
ascending sort or the Descending arrow

for an

for a descending sort.

Step 7

To arrange the fields, use the Move Up arrow

Step 8

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.

.

Summary Columns Section
Step 9

If a Sum applies to your report, select a field to sum by checking the box in the SUM
column.
Any Sum fields will have a subtotal at each Group By level. When displayed to a user, a
report containing a Summary (total) row ignores the value of the Result Size property.

Step 10 Click Save.

© Copyright IBM Corporation 2011, 2015.

60

Filters Tab
The Filters tab uses fields, operators, and values to focus the results to display. The
information in the Filters tab is organized into four sections:
•
•
•
•

The Business Object section on the upper left indicates the source business objects.
The Columns section on the lower left identifies which fields in the selected business object to use
as filters.
The User Filter Columns and System Filter Columns sections specify filters, so that only records
with fields that contain values that meet the specified criteria are included in a report.
For additional filtering, you can use the Advanced tab to filter records based on their association
with other records.

The selected filters are executed sequentially, from top to bottom. Plan the sequence
ahead of time. Reports run faster if the filter that filters out the most records is
specified first, followed by the one that filters out the next highest number of
records, and so on.
Step
Business Object Section
The business objects listed in the Business Object section are from the Business Objects sub-tab
in the My Report tab.
Step 1

Select the Business Object.

Columns Section
The fields displayed in the Columns section depend on the selected business object.
The columns in the Columns section are:
User: The filter value will be specified at runtime by the user. A user filter has no impact on the
total results that the user sees.
System: The filter value limits the total results that the user sees. A system filter is applied by
the system each time a report executes.
Field Label: The label for the field.
Field Name: The system name for the field.
Step 2

For each field used as a filter, select the check box in either or both the User or System
column. The system adds the selected fields to the User Filter Columns section and the
System Filter Columns section.

When you select a different business object, the fields displayed in the Columns section change,
but previously selected fields in the User Filter Columns section and System Filter Columns
section remain.
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Step
User Filter Columns Section and System Filter Columns Section
When you select a User check box in the Columns section, the field appears in the list in the User
Filter Columns section.
When you select a System check box in the Columns section, the field appears in the list in the
System Filter Columns section.
Clearing a check box in the Columns section removes the field from the corresponding filter
columns list.
The Field column shows the field’s label and system name.
To see the source of a field, hover your mouse over the hyperlink in the Field column.
Step 3

To change the sequence in which the filters apply, select a field and click Move up,
Move down, Move to top, or Move to bottom. Organize filters so that the filters that
eliminate the most records are listed first.

Step 4

To change the label that displays for a filter, edit the text in the Report Label text box.
The report labels only apply if runtime filters are used, and then only if the field is not
already displayed, or if the filter is a second runtime filter against the same field.
If the field is a Time field, the user must input the time in milliseconds or as a string in
hh:mm:ss format.

Step 5

From the Filter Operator drop-down box, select the comparison filter operator.
The choices presented depend on the field type of the selected field.
For more information about the available operators, see Appendix A: Filter Operators.

Step 6

For system filters that the user provides a value for at runtime, specify the Value that
must be matched. To filter a Boolean field, use the values TRUE or FALSE.
For more information about the special values, see Appendix B: Special Values.

Step 7

To organize system filters in sets to further refine the order in with the filters are
applied, select the Join Operator.
The join operator provides one layer of grouping. For the first field, the choices are
blank and NOT. For subsequent fields, the choices are AND, OR, AND NOT, and OR NOT.
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Step
Step 8

To organize nested filters, use the selections in the numbered drop-down.
The join operator provides one layer of grouping.

Step 9

Select the Join Operator. For the first field, the choices are blank and NOT. For
subsequent fields, the choices are AND, OR, AND NOT, and OR NOT.
Another layer of system filter grouping comes from the column to the right of the Join
Operator column and the column to the right of the Value column. Together they provide
the ability to define sets of filters. The filters in each group are applied as a unit before
joining their result with the rest of the filters.
You can organize groups within groups. The innermost group will be applied first, all the
way up to the outermost group.

Step 10 To organize nested filters, use the selections in the numbered drop-down.
Step 11 Click Save.
Step 12 If your filter groups are uneven, the system displays an error message and does not apply
your changes. See the example in Appendix D: Example of User Filters and System
Filters.
Step 13 To copy an existing filter and create one with the same source, select the filter item and
click Copy.
A new identical row appears below the copied row. The copy of a User filter appears in
the User Filter Columns section. The copy of a System filter appears in the System Filter
Columns section. The system clears any groupings in the System Filter Columns section.
Step 14 Adjust the values in the filter properties, as described above.
Step 15 To remove a row, select the row and click Remove.
If you click Remove and this is the only row that refers to a field in the Columns section,
the system clears the field’s check box in the Columns section.
If you clear the check box in the Columns section, the system removes all rows in both
filter columns sections that refer to that field.
Step 16 Click Save.
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Advanced Tab
Using the Advanced tab, you can filter records based on their association with other
records. For additional filtering, use the Filters tab to target the search results
displayed using fields, operators, and values.
Step
Association Filters Section
Step 1

On the Association Filters section bar, click Add.
You can define the type of associated records by which you want to filter the results of
the report.
To avoid potential report performance issues, avoid using –Any- for the module
selection and All for the business object selection whenever possible.

Step 2

Select the Module.

Step 3

Select the Business Object.
To include all business objects in the selected module, select All.
The choices in Business Object depend on the selected module.

Step 4

Click OK.

The new filter appears in the Association Filters section.
Step 5

To delete an association filter, select the check box and click Delete.

Step 6

Select the Association Type.
This is the association type defined from the perspective of the filtering module and
business object specified immediately above. To include all association types, select
ALL.

Step 7

All new reports will have aReverse Association set toNo. If an existing report has a
Reverse Association set to Yes, a warning message will display. If a report used in the
association filter down the line has a Reverse Association set to Yes, a warning message
will display. To remove the warning message, set the Reverse Association to No.
It is no longer possible to set the Reverse AssociationFlag. Only existing reports with the
flag set will be able to show the flag in the association filter. When the Reverse
Association is set to No, it is not possible to set it back to Yes.
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Step
Step 8

To specify which records to use to filter the result set of the report or query for which
the association filter is defined, use the Filter Type and Record / Query fields.
You can specify a specific filtering record through the use of special name values. You
can specify multiple filtering records by choosing Query in the Filter Type field and then
choosing a query that returns the filtering records in the Record / Query field. For more
information about both of these fields, see Appendix C: Special Names in Record Field,
and the Application Building for the IBM TRIRIGA Application Platform 3 book.

Step 9

Click OK.

Step 10 To delete an association filter, select the check box, and click Delete.
Step 11 Click Save.

My Report: Hierarchy
When a report record’s type is Hierarchy, the result lists records up and down a
hierarchy.

My Report Tab
Define the report and its scope in the My Report tab of the report record.
Step
Complete identifying information about the report.
Step 1

Specify the Nameof the report.
Names must be unique. Use the naming conventions described in the Naming Conventions
section in this user guide.

Step 2

Specify the IDto further identify the report. Use CUSTOM or your company’s numbering
standards for reports.

Step 3

Specify the Header (Title). This is the text that shows at the top of the report.

Step 4

To use an additional grouping for filtering, specify the Tag.

Step 5

Specify a complete Descriptionof the report.

Step 6

In the Type field, select Report.
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Step
The Business Objects, Options, Related Reports, and Security sub-tabs provide more particulars
about the report.

Business Objects Sub-Tab
The Business Objects sub-tab identifies the data available to this report record.
Step
Step 1

In the Business Objects sub-tab, select Add Business Object.

Step 2

Select the Module.

Step 3

Select the Business Objects.
If you select –All-, the report works with any data from any business object in the
specified module.
If you select the name of one or more business objects, the report works only with data
from the specified business objects.
To select multiple business objects, hold the Ctrl or Shift key and click your selections. If
you select multiple business objects, you can only select fields from the base business
object.

Step 4

Select the Forms.
If you select –All-, the data included in the report will not be filtered by form. If you
select the name of one or more forms, only data associated with the specified forms are
included in the report. To select multiple forms, hold the Ctrl or Shift key and click your
selections.

Step 5

Click OK.

Step 6

Click Save.
The Run Report action becomes available. Use Run Report any time you want to test
your report design.
The Edit and Remove actions become available to manage the list in the Business
Objects sub-tab.

Step 7

To edit a business object line item, either click the hyperlink or select the radio button
and click Edit.
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Step
Step 8

Optional: Select other business objects.

Step 9

Click Add Business Object.
To add a child business object, select the parent business object before clicking Add
Business Object.

Step 10 To edit a business object line item, either click the hyperlink or select the radio button
and click Edit.
Step 11 Optional: Select other business objects.
Step 12 Click Add Business Object.
Step 13 To add a child business object, select the parent business object before clicking Add
Business Object.
Step 14 Select the Module.
Step 15 From the Business Object list, select from the business object.
To select multiple business objects, hold the Ctrl or Shift key and click your selections.
Step 16 Select Associated Options.
To select multiple associated options, hold the Ctrl or Shift key and click your selections.
Step 17 Optional: Deselect Show only Associations defined in Data Modeler.
This check box is selected by default to help limit the number of associations that appear
in drop-down boxes. If deselected, the form displays all modules, all business objects
relative to the selected module, and all association types in the system.
Step 18 To designate this object as the Primary Associated Business Object, check the box.
The Primary Associated Business Object check box only displays for direct descendants,
i.e., child associations. By default, it is selected for the first child business object added.
If you remove the designated primary associated business object, the system designates the next
associated business object in the tree as the primary associated business object.
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Step
Step 19 Click OK.
The new object appears in the Business Objects sub-tab under the selected parent
business object. Indentation identifies parent business objects and their children.
When an associated business object is the Primary Associated Business Object, it is
denoted by a purple square after the module name in the Module column.
The Remove action does not apply to the primary business object. To change the
primary business object, edit its properties.
To remove a non-primary business object, select the business object and click Remove.
If you remove an associated business object, you cannot use the fields from that business
object for the report.
If you remove a business object that is part of a hierarchical list, the system also
removes its children.
Step 20 Click Save.

Options Sub-Tab
The Options sub-tab contains elements that are unique to the Hierarchy report
type.
Step
When the report type is Hierarchy, the Options sub-tab presents the following options.
Step 1

Select a value for Data Scope. The default value is Active Project.
The Data Scope limits the data that are accessible to the report.

Value

Description

Active
Project

The data available to the report is restricted to the active project. If the
parent record is a capital project, the active project is the record itself. If
the parent record is not a capital project, the active project is the project in
which the parent record resides.

Company

Only data that exists outside a project is accessible to the report.

All
Projects

The report includes all data records, without regard to project or company.
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Step
Step 2

To fix the left-hand columns in the report, specify the number of columns in Fixed
Column Count. The default value is 0 (zero). Limit the fixed columns to five or less.
Fixed columns do not move as the user scrolls the report horizontally. After the report
runs, users can identify the fixed columns because they have a thicker border to the
right of the last fixed column.

Step 3

To specify the default size when the system runs the report, use Result Size.
The default value for this drop-down box is for it to be empty, in which case the
platform determines the result size.

Step 4

To specify an Excel Template, click the Search icon

.

The data displayed in a report can be formatted as a Microsoft Excel spreadsheet by
applying an Excel template retrieved from the Document Manager.
You can use the Name field to search for Excel templates that start with the text you
specify. Use the % character in the Name field as a wild card to widen your search to any
word in the name. For example, type %security to find a template with the word
security anywhere in the name.
Step 5

Select the Excel template and click Accept.

Step 6

For Editable, select Yes or No.
Editable determines whether a user can edit the values in the records displayed in the
report directly from the report.

Step 7

Select the Module.

Step 8

Select the Query.
A report can contain hierarchical queries nested for multiple levels: 1) the original, 2)
the associated query, and 3) the associated query of that associated query. Additional
levels of associated queries are possible, but the typical limit is three levels.
Use hierarchical queries to display associated data in a hierarchical fashion. The toplevel queries must have their Type property set to Hierarchy and point to the query
(Associated Query) below them. Bottom-level (associated) queries need an Association
Filter filtering by $$RECORDID$$ representing the selected record. Mid-level queries
combine both of these attributes.
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Step
Step 9

Choose the appropriate Child Column Display value.
The parameters in Child Column Display configure the display and usability of
hierarchical queries.
The drop-down box offers two options: Show headers and indent columns, and Suppress
headers and align columns.
The default option of Show headers and indent columns displays child rows
indented but not aligned, along with the corresponding column headers.
In cases like program and project hierarchies, where the child rows display similar data
to the parent rows at all levels in the hierarchy, another option is available. Suppress
headers and align columns displays the child rows aligned with their parent rows,
and hides the duplicated column headings.

Step 10 When the Enable Project Switching check box is selected, users experience quick and
easy navigation through program and project hierarchies in a portal section. Users see
the Portal Switching icon
before the hyperlinked project type.
The
icon displays only if the record is a Capital Project record and the user has
appropriate project security permissions.


When a user clicks the
for a record in a non-default project, the project context
switches to that record’s project.



When a user clicks the
for a record in a default project, the project context switches
to the Company Level, if not already there.
By default, Enable Project Switching is not selected.

Step 11 Optional: Select Enable Project Switching.
Step 12 Click Save.
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Related Reports Sub-Tab
A related report is a self-contained report that has its own definition and format. The
typical purpose is to display additional information the viewer might find relevant. A
main report can have more than one related report. A related report cannot have
another related report. Values can be passed between a main report and a related
report using shared variables. Generally, a related report contains a reference back to
the main report. Specify any related reports in the Related Reports sub-tab.
Step
When the report type is Hierarchy, the Related Reports sub-tab presents the following options.
Step 1

To add a related report, select Add.

Step 2

On the section bar, click the Filter icon

Step 3

To restrict the reports displayed to only one report type, select a report type.

.

The default is Report. To see all types of reports, select All.
The report types are explained elsewhere in this chapter.
Step 4

Select the Module.
The drop-down box contains only modules for which you have security access.
The system displays My Reports and Community reports (designated by the C) matching
the selected report type and module.

Step 5

Select the check boxes of the related reports.

Step 6

Click OK.
When available, clicking a hyperlink opens the definition of that report.

Step 7

To change the sequence of the related reports, click the arrows in the Order column and
move a related report up or down in the list.
Related reports will appear in the presentation in the same sequence as they appear in
the Related Reports sub-tab, from top to bottom.

Step 8

Click Save Order.

Step 9

Select the check boxes of the related reports.

Step 10 Click OK.
When available, clicking a hyperlink opens the definition of that report.
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Step
Step 11 To delete a related report, select the check box and click Remove.
Step 12 Click Save.

Security Sub-Tab
The Security sub-tab names groups that can access this report.
Step
When the report type is Hierarchy, the Security sub-tab presents the following options.
Although not shown in the Security sub-tab, the system automatically adds the user creating the
report to the Security Access section. The owner has full access privileges.
To grant access to groups, use the Add action on the Security Access section bar.
Step 1

Click Add.

Step 2

Select the check boxes of the groups to have access to the report.

Step 3

Click Accept.
By default, every group listed has View access.

Step 4

To grant additional access to a group, select All, Edit, Delete, Copy, or Share.

Step 5

To delete a group, select the check box and click Remove.

Step 6

Click Save.

To grant access to groups, use the Add action on the Security Access section bar.
Step 7

Click Add.
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Columns Tab
The Columns tab defines which fields to use in the report. The information in the
Columns tab is organized into three sections:
•
•
•

The Business Object section on the upper left indicates the source business objects.
The Columns section on the lower left identifies which fields in the selected business object to
include in the report.
The Display Columns section on the right specifies the order in which the selected fields are
presented and the labels used to identify them.
Step
Business Object Section
Step 1

Select the Business Object. The fields in the selected business object display in the
Columns section.
The business objects listed in the Business Object section are from the Business Objects
sub-tab in the My Report tab.

Columns Section
Step 2

Select the check box for each field to include in the report. The system adds the
selected fields to the Display Columns section.
The fields displayed in the Columns section come from the selected business object.
When you select a different business object, the fields displayed in the Columns section
change but previously selected fields in the Display Columns section remain.

Display Columns Section
When you select a check box in the Columns section, the field appears in the list in the Display
Columns section.
Clearing a check box in the Columns section removes the field from the Display Columns list.
The Field column shows the field’s label and system name.
Step 3

To change the sequence in which the fields display, select a field and click Move up,
Move down, Move to top, or Move to bottom.

Step 4

To change the label that displays for a field, edit the text in the Report Labeltext box.

Step 5

To specify a percentage of the display space for a field, specify a numerical value in the
Width text box.

Step 6

To remove a field, select the field and click Remove.

Step 7

Click Save.
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Order & Group Tab
The Order & Group tab defines the layout of the data in the report. You can organize
the layout by group, into a specific sequence, or neither. The data, found in the left
side of the Group By and Order By sections, comes from the selections made in the
Columns tab.
Step
Group By Section
Step 1

In the left column, select the field to Group By.

Step 2

To move the selected field to the right column, use the Move Right arrow

Step 3

To arrange the fields, use the Move Up arrow

Step 4

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.
.

.

Order By Section
Step 5

In the left column, select the field to Order By.

Step 6

To move a selected field to the right column, you can use the Ascending arrow
ascending sort or the Descending arrow

for an

for a descending sort.

Step 7

To arrange the fields, use the Move Up arrow

Step 8

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.

.

Summary Columns Section
Step 9

If a Sum applies to your report, select a field to sum by checking the box in the SUM
column.
Any Sum fields will have a subtotal at each Group By level. When displayed to a user, a
report containing a Summary (total) row ignores the value of the Result Size property.

Step 10 Click Save.
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Filters Tab
The Filters tab uses fields, operators, and values to focus the results to display. The
information in the Filters tab is organized into four sections:
•
•
•
•

The Business Object section on the upper left indicates the source business objects.
The Columns section on the lower left identifies which fields in the selected business object to use
as filters.
The User Filter Columns and System Filter Columns sections specify filters, so that only records
with fields that contain values that meet the specified criteria are included in a report.
For additional filtering, you can use the Advanced tab to filter records based on their association
with other records.

The selected filters are executed sequentially, from top to bottom. Plan the sequence
ahead of time. Reports run faster if the filter that filters out the most records is
specified first, followed by the one that filters out the next highest number of
records, and so on.
Step
Business Object Section
The business objects listed in the Business Object section are from the Business Objects sub-tab
in the My Report tab.
Step 1

Select the radio button for a business object.

The fields in the selected business object display in the Columns section.
Columns Section
The fields displayed in the Columns section depend on the selected business object.
The columns in the Columns section are:
User: The filter value will be specified at runtime by the user. A user filter has no impact on the
total results that the user sees.
System: The filter value limits the total results that the user sees. A system filter is applied by
the system each time a report executes.
Field Label: The label for the field.
Field Name: The system name for the field.
Step 2

For each field used as a filter, select the check box in either or both the User or System
column. The system adds the selected fields to the User Filter Columns section and the
System Filter Columns section.

When you select a different business object, the fields displayed in the Columns section change,
but previously selected fields in the User Filter Columns section and System Filter Columns
section remain.

© Copyright IBM Corporation 2011, 2015.

75

Step
User Filter Columns Section and System Filter Columns Section
When you select a User check box in the Columns section, the field appears in the list in the User
Filter Columns section.
When you select a System check box in the Columns section, the field appears in the list in the
System Filter Columns section.
Clearing a check box in the Columns section removes the field from the corresponding filter
columns list.
The Field column shows the field’s label and system name.
To see the source of a field, hover your mouse over the hyperlink in the Field column.
The system applies filters sequentially from top to bottom in the list.
Step 3

To change the sequence in which the filters apply, select a field and click Move up,
Move down, Move to top, or Move to bottom. Organize filters so that the filters that
eliminate the most records are listed first.

Step 4

To change the label that displays for a filter, edit the text in the Report Label text box.
The report labels only apply if runtime filters are used, and then only if the field is not
already displayed, or if the filter is a second runtime filter against the same field.
If the field is a Time field, the user must input the time in milliseconds or as a string in
hh:mm:ss format.

Step 5

From the Filter Operator drop-down box, select the comparison filter operator.
The choices presented depend on the field type of the selected field.
For more information about the available operators, see Appendix A: Filter Operators.

Step 6

For system filters that the user provides a value for at runtime, specify the Value that
must be matched. To filter a Boolean field, use the values TRUE or FALSE.
For more information about the special values, see Appendix B: Special Values.

Step 7

To organize system filters in sets to further refine the order in with the filters are
applied, select the Join Operator.
The join operator provides one layer of grouping. For the first field, the choices are
blank and NOT. For subsequent fields, the choices are AND, OR, AND NOT, and OR NOT.
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Step
Another layer of system filter grouping comes from the column to the right of the Join
Operator column and the column to the right of the Value column. Together they provide
the ability to define sets of filters. The filters in each group are applied as a unit before
joining their result with the rest of the filters.
You can organize groups within groups. The innermost group will be applied first, all the
way up to the outermost group.
Step 8

To organize nested filters, use the selections in the numbered drop-down.

Step 9

Click Save.
If your filter groups are uneven, the system displays an error message and does not apply
your changes. See the example in Appendix D: Example of User Filters and System
Filters.

Step 10 To copy an existing filter and create one with the same source, select the filter item and
click Copy.
A new identical row appears below the copied row. The copy of a User filter appears in
the User Filter Columns section. The copy of a System filter appears in the System Filter
Columns section. The system clears any groupings in the System Filter Columns section.
Step 11 Adjust the values in the filter properties, as described above.
Step 12 To remove a row, select the row and click Remove.
If you click Remove and this is the only row that refers to a field in the Columns section,
the system clears the field’s check box in the Columns section.
If you clear the check box in the Columns section, the system removes all rows in both
filter columns sections that refer to that field.
Step 13 Click Save.
If your filter groups are uneven, the system displays an error message and does not apply
your changes. See the example in Appendix D: Example of User Filters and System
Filters.
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Advanced Tab
Using the Advanced tab, you can filter records based on their association with other
records. For additional filtering, use the Filters tab to target the search results
displayed using fields, operators, and values.
Step
Association Filters Section
Step 1

On the Association Filters section bar, click Add.
You can define the type of associated records by which you want to filter the results of
the report.
To avoid potential report performance issues, avoid using –Any- for the module
selection and All for the business object selection whenever possible.

Step 2

Select the Module.

Step 3

Select the Business Object.
To include all business objects in the selected module, select All.
The choices in Business Object depend on the selected module.

Step 4

Select the Association Type.
This is the association type defined from the perspective of the filtering module and
business object specified immediately above. To include all association types, select
ALL.

Step 5

All new reports will have aReverse Association set toNo. If an existing report has a
Reverse Association set to Yes, a warning message will display. If a report used in the
association filter down the line has a Reverse Association set to Yes, a warning message
will display. To remove the warning message, set the Reverse Association to No.
It is no longer possible to set the Reverse AssociationFlag. Only existing reports with the
flag set will be able to show the flag in the association filter. When the Reverse
Association is set to No, it is not possible to set it back to Yes.

Step 6

To specify which records to use to filter the result set of the report or query for which
the association filter is defined, use the Filter Type and Record / Query fields.
You can specify a specific filtering record through the use of special name values. You
can specify multiple filtering records by choosing Query in the Filter Type field and then
choosing a query that returns the filtering records in the Record / Query field. For more
information about both of these fields, see Appendix C: Special Names in Record Field,
and the Application Building for the IBM TRIRIGA Application Platform 3 book.
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Step
Step 7

Click OK.

Step 8

To delete an association filter, select the check box, and click Delete.

Step 9

Click Save.

Community
The Community tab in the Report Manager contains a collection of generally available
system reports. A report displays in the Community tab if it was designated to do so
by your system administrator.
Not all users have access to the Community tab. If you have access to the Community
tab, your view may be different from that described in this user guide. Depending on
your security settings, you may see some or all of the features.
The column headings displayed in the Community tab follow.
Column Heading

Description

Blank

Displays the Run Report icon . When you click the , the system
generates the report and displays it in a separate window.

Title

The title of the report

Name

The system name of the report.

Tag

A name that can be filtered from the Report Manager, often used for
collections of reports.

Module

The module of the report.

Business Object

The business object of the report.

Form

The display for the report. If it is a module- or business object-level
report, this field shows a comma-separated list of forms.

Display Type

The kind of report. Values include –All-, Report, Query,
Graphic, Summary, Chart, External, Reserve Legacy,
Reserve, Hierarchy, and Metric.

Owner Language

The original language of the report owner.
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Use the filters in the column headings to find the report you need.
The action available on the Community tab follows.
Action Name

Description

Copy as My Report

Makes a copy of a selected report and pastes the copy in your My
Reports tab. The copied version has the words “Copy of” at the
beginning of the report name. To copy a report to your My Reports
tab, select the check box and click Copy as My Report.

You manage the reports in the Community tab from the System Reports tab.
The following briefly describes the report types available for Community reports:


Report is a basic tabular report. A Report is listed in a navigation item.



Query is a basic tabular report. A Query is not listed in a navigation item.



Graphic is outside the scope of this guide. For more information, go to the
IBM TRIRIGA Application Platform 3 Knowledge Center and select Administering
IBM TRIRIGA Application Platform>Managing graphics.



Summary is a tabular report. It differs from reports and queries in the way that
detail records are handled. In a report or query, all detail records that
contribute to totals display in the report. A Summary report shows the totals
without the detail records.



Chart displays the data in a chart. Four kinds of charts are supported: pie,
bar, line, and stacked bar.



External specifies that the report was created using third-party software,
such as BIRT.



Reserve Legacy is a query that returns the results of available resources
only.



Reserve is a query that acts like the Reserve Legacy query, but it also adds
support for calendar sets to determine the availability of resources.



Hierarchy uses a query to show information up and down a hierarchy.



Metric aggregates data in a table or chart with drill paths, filters, and related
reports. You can create metric reports based on instance data (business object
data) or on Fact Tables (as done in IBM TRIRIGA’s Workplace Performance
Management, IBM TRIRIGA Real Estate Environmental Sustainability, and IBM
TRIRIGA Strategic Facility Planning products).
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System Reports
The System Reports tab in the Report Manager contains reports used by the IBM
TRIRIGA applications. A report displays in the System Reports tab if it is an IBM
TRIRIGA standard report, if it was created by a user with access to the System Reports
tab, or if it was copied to System Reports as a Community report from a user’s My
Reports tab.
You may not have access to the System Reports tab. If you have access to the System
Reports tab, your view may be different from that described in this user guide.
Depending on your system security settings, you may see some or all of the features.
The column headings in the System Reports tab follow. Click the hyperlink to open the
Report Builder definition of a report.
Column Heading

Description

Blank

Displays the Run Report icon . When you click the , the system
generates the report and displays it in a separate window.

C

Indicates whether the report is designated to appear in the
Community tab. The value C means the report displays in the
Community tab.

Title

The title of the report

Name

The system name of the report.

Tag

A name you can filter on from the Report Manager. Use this field to
build collections of related reports.

Module

The module of the report.

Business Object

The business object of the report.

Form

The display for the report. If it is a module- or business object-level
report, this field shows a comma-separated list of the forms.

Display Type

The kind of report. Values include –All-, Report, Query,
Graphic, Summary, Chart, External, Reserve Legacy,
Reserve, Hierarchy, and Metric.

The first time you select the System Reports tab, the system does not show any
reports. At any time, you can use the filters in the column headings to find the report
of interest.
The actions available on System Reports in the Report Manager follow.
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Action Name

Description

New

Opens the form for creating a new report record.

Copy

Makes a copy of a selected report and pastes the copy in the System
Reports tab. The copied version has the words “Copy of” at the
beginning of the Name. To copy a report, select the check box and
click Copy.

Delete

Removes the selected report permanently from the Report Manager.
To delete a report, select the check box and click Delete. In the
delete confirmation window, click OK.

Copy as My Report

Makes a copy of the selected report and pastes the copy in your My
Reports tab. The copied version has the words “Copy of” at the
beginning of the Name. To copy a report to your My Reports tab,
select the check box and click Copy as My Report.

Share as Community

Designates the selected report as a Community report. The report
becomes visible in the Community tab of all users that have security
access to view the data within. To share a report to the Community
tab, select the check box and click Share as Community.

Validate

Only available for Metric reports. Use Validate as a debugging tool to
ensure that the report is properly constructed. For example, for a
Line-Bar Combo chart, the system checks that the main query and
the line data source query have identical filters specified and
identical Group By specified.

Creating a New System Report
From the System Reports tab, you click New to create a report.
A description of each action at the top of the report form follows. Some actions
appear only after you save the Report form.
Action Name

Description

Save

Saves the current report definition to the report record.

Save & Close

Saves the current report definition to the report record and closes
the report form.

x

Closes the form. The system does not save any changes made since
the last Save or Save & Close action.
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Action Name

Description

Run Report

Generates the report and displays it in a secondary window.
Available only after you save the report record.

Validate

Available only for Metric reports. You use Validate as a debugging
tool to ensure proper construction of the report. For example, for a
Line-Bar Combo chart, the system checks that the main query and
the line data source query have identical filters specified and
identical Group Bys specified.

The Type field on the General tab identifies the report type.
The following briefly describes the report types available for system reports:


Report is a basic tabular report. A Report is listed in a navigation item.



Query is a basic tabular report. A Query is not listed in a navigation item.



Graphic is outside the scope of this guide. For more information, go to the
IBM TRIRIGA Application Platform 3 Knowledge Center and select Administering
IBM TRIRIGA Application Platform>Managing graphics.



Chart displays the data in a chart. The chart types include: pie, bar, line, and
stacked bar.



Summary is a tabular report. It differs from reports and queries in the way that
it handles detail records. In a report or query, all detail records that contribute
to totals display in the report. A Summary report shows the totals without the
detail records.



External specifies that the report was created using third-party software,
such as BIRT.



Reserve Legacy is a query that returns the results of available resources
only.



Reserve is a query that acts like the Reserve Legacy query, but it also adds
support for calendar sets to determine the availability of resources.



Hierarchy uses a query to show information up and down a hierarchy.



Metric aggregates data in a table or chart with drill paths, filters, and related
reports. You can create metric reports based on instance data (business object
data) or on Fact Tables (as done in the IBM Workplace Performance
Management, IBM TRIRIGA Real Estate Environmental Sustainability, and IBM
TRIRIGA Strategic Facility Planning products).
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Complex Queries
When you build a complex query with multiple associated business objects, be aware
of the limits of the database in use. One method of verifying a suitable query for the
database is to export the SQL of the query. From the Advanced tab, select the Export
SQL link. Run that SQL code on the database to verify that no errors occur.

System Report Tabs
The following sections in this chapter describe each tab in the Report form for a
System Report. The discussion uses a Report for purposes of illustration and points
out any unique requirements for the different report types.


General Tab



Columns Tab



Order & Group Tab



Filters Tab



Advanced Tab



Where Used Tab

General Tab
You define the report and its scope in the General tab of the report record.
Step
Complete identifying information about the report.
Step 1

Specify the Nameof the report.
Names must be unique. Use the naming conventions described in the Naming Conventions
section in this user guide.

Step 2

Specify the IDto further identify the report. Use CUSTOM or your company’s numbering
standards for reports.

Step 3

Specify the Header (Title). This is the text that shows at the top of the report.

Step 4

To use an additional grouping for filtering, specify the Tag.

Step 5

Specify a complete Descriptionof the report.
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Step
Type indicates what sort of report this record will be. Standard choices are Report,
Query, Graphic, Chart, Summary, External, Reserve Legacy, Reserve,
Hierarchy, and Metric.
The fields that display in this tab and the other tabs in this form vary, based on your
selection for Type.
If the report Type is Reserve, Calendar Set displays. Select a value for Calendar Set.
Step 6

Select Reportfrom the drop-down box.

The Data Scope limits the data that are accessible to the report.
Step 7

Select a value for Data Scope.
The values include:
Active Project: The data available to the report is restricted to the active project.
If the parent record is a capital project, the active project is the record itself. If the
parent record is not a capital project, the active project is the project in which the
parent record resides.
Company: Only data that exists outside a project is accessible to the report.
All Projects: The report includes all data, without regard to project or company.

Step 8

If this report is to be available in the Community tab, select Show As Community Report.
The Security sub-tab does not display when the Show As Community Report check box is
deselected.

Business Objects Sub-Tab
The Business Objects sub-tab identifies the data available to this report record. The
appearance and purpose of the Business Objects sub-tab are different for Metric
reports. This section first describes the Business Objects sub-tab for non-Metric
reports, then for Metric reports.

Non-Metric Reports
Step
Step 1

In the Business Objects sub-tab, select Add Business Object.
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Step
Step 2

Select the Module.

Step 3

Select the Business Objects.
The Business Object specifies whether the report works with data from any business
object in the module or if it will be constrained to work with data from specific business
objects.
The list contains –All- and the names of the business objects in the specified module.
If you select –All-, the report works with any data from any business object in the
specified module.
If you select the name of one or more business objects, the report works only with data
from the specified business objects.
To select multiple business objects, hold the Ctrl or Shift key and make your selections.
If you select multiple business objects, you can select only fields from the base business
object.

Step 4

Select the Forms.
The list contains –All- and the names of forms that you can use to edit the data from
the specified business objects.
If you select –All-, the data included in the report will not be filtered by form.
If you select the name of one or more forms, only data associated with the specified
forms are included in the report.
To select multiple forms, hold the Ctrl or Shift key and click your selections.

Step 5

Click OK.

Step 6

Click Save.
After you click Save, the Run Report action becomes available. Use Run Report any
time you want to test your report design.
After you click Save, the Edit and Remove actions become available to manage the list
in the Business Objects sub-tab. To edit a business object line item, either click the
hyperlink or select the radio button and click Edit.

Step 7

Optional: Select other business objects.

Step 8

Click Add Business Object.
To add a child business object, select the radio button of the parent business object
before you click Add Business Object.
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Step
Step 9

Select the Module.

Step 10 Select the Business Object.
To select multiple business objects, hold the Ctrl or Shift key and click your selections.
Step 11 Select the Associated Options.
To select multiple associated options, hold the Ctrl or Shift key and make your
selections.
Step 12 Optional: Deselect Show only Associations defined in Data Modeler.
This check box is selected by default to help limit the number of associations that appear
in drop-down boxes. If deselected, the form displays all modules, all business objects
relative to the selected module, and all association types in the system.
Step 13 To designate this object as the Primary Associated Business Object, check the box.
The Primary Associated Business Object check box displays only for direct descendants,
i.e., child associations. By default, it is selected for the first child business object added.
If you remove the designated primary associated business object, the system designates
the next associated business object in the tree as the primary associated business
object.
When an associated business object is the Primary Associated Business Object, it is
denoted by a purple square after the module name in the Module column.
Step 14 Click OK.
Step 15 To remove a non-primary business object, select its radio button and click Remove.
If you remove an associated business object, you cannot use the fields from that business
object for the report.
The Remove action does not apply to the primary business object. To change the
primary business object, edit its properties.
If you remove a business object that is part of a hierarchical list, the system also
removes its children.
Step 16 Click Save.
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Metric Reports
Step
Step 1

In the Business Objects sub-tab, select Add Business Object.

Step 2

Select the Module.

Step 3

Select the Business Objects.
The list contains –All- and the names of the business objects in the specified module.
If you select –All-, the report works with any data from any business object in the
specified module.
If you select the name of one or more business objects, the report only works with data
from the specified business objects.
To select multiple business objects, hold the Ctrl or Shift key and click your selections. If
you select multiple business objects, you only can select fields from the base business
object.

Step 4

Select the Forms.
The list contains –All- and the names of forms that you can use to edit the data from
the specified business objects.
If you select –All-, the data included in the report will not be filtered by form.
If you select the name of one or more forms, only data associated with the specified
forms are included in the report.
To select multiple forms, hold the Ctrl or Shift key and click your selections.

Step 5

Click OK.

Step 6

Click Save.
After you click Save, the Run Report action becomes available. Use Run Report any
time you want to test your report design.
After you click Save, the Edit and Remove actions become available to manage the list
in the Business Objects sub-tab.

Step 7

To edit a business object line item, either click the hyperlinked name or select the radio
button and click Edit.

Step 8

Click Save.
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Options Sub-Tab
The Options sub-tab contains elements that are unique to the report type.
Step
Report or Query
When the report type is Report or Query, the Options sub-tab presents the following options.
Step 1

For Random Result Count, specify a value or leave the 0 (zero) default.
Use Random Result Count if there are so many data records that including all of them in
a report would not be useful or practical.
This field’s default value is 0 (zero). If this field is set to a positive number, the report
only includes the specified number of records randomly chosen from the complete set of
data.

Step 2

To fix and not move five or less of the left-hand columns in the report as the user scrolls
the report horizontally, specify the number of columns in Fixed Column Count.
Performance degrades as the number of fixed columns increases beyond 5.
After the report runs, users can identify the fixed columns because they have a thicker
border to the right of the last column that is fixed.
The default value is 0 (zero).

Step 3

To specify the default size when the system runs the report, use Result Size.
The default value is empty, in which case the platform determines the result size.

Step 4

To specify an Excel Template, click the Search icon

.

You can format the data displayed in a report as a Microsoft Excel spreadsheet by
applying an Excel template retrieved from the Document Manager.
You can use the Name field to search for Excel templates that start with the text you
specify. Use the % character in the Name field as a wild card to widen your search to any
word in the name. For example, type %security to find a template with the word
security anywhere in the name.
Step 5

Select the Excel template and click Accept.
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Step
Step 6

To allow the report’s user to specify runtime filters that specify initial criteria before the
report executes, select Prompt Before Query.
When the Prompt Before Query check box is deselected, the report executes
immediately when selected by the user.
Select Prompt Before Query for all performance-intensive reports.

Step 7

For Editable, select Yes or No.
Editable determines whether a user can edit the values in the records displayed in the
report directly from the report.

Chart
When the report type is Chart, the Options sub-tab presents the following options.
Step 8

For Graph X Title, specify the text to use as the title for the X-axis of the chart.

Step 9

For Graph Y Title, specify the text to use as the title for the Y-axis of the chart.

Step 10 For Graph Type, select the chart type.
Step 11 To display the legend on the chart, select Display Legend.
By default, Display Legend is deselected, which optimizes the chart viewing area.
Charts honor the Display Legend value except when maximized. When maximized, the
legend always displays.
For charts that display in a small area, leave the Display Legend property deselected.
Step 12 Optional: Specify a value for Precision.
Step 13 Precision specifies the number of decimal places to display in the chart and in the chart
hover information. Precision must be greater than or equal to 0 and less than 13.
Step 14 See the descriptions above for Excel Template, Prompt Before Query, and Editable.
Summary
When the report type is Summary, the Options sub-tab presents the following options.
Step 15 See the descriptions above for Excel Template, Prompt Before Query, and Editable.
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Step
Hierarchy
When the report type is Hierarchy, the Options sub-tab presents the following options.
Step 16 See the descriptions above for Fixed Column Count, Result Size, Excel Template and
Editable.
Step 17 Select the Module.
Step 18 Select the Query.
A report can contain hierarchical queries nested for multiple levels: 1) the original, 2)
the associated query, and 3) the associated query of that associated query. Additional
levels of associated queries are possible, but the typical limit is three levels.
Use hierarchical queries to display associated data in a hierarchical fashion. The toplevel queries must have their Type property set to Hierarchy and point to the query
(Associated Query) below them. Bottom-level (associated) queries need an Association
Filter filtering by $$RECORDID$$ representing the selected record. Mid-level queries
combine both of these attributes.
Step 19 Select a Child Column Display value.
The parameters in Child Column Display configure the display and usability of
hierarchical queries.
The default option of Show headers and indent columns displays child rows
indented but not aligned, along with the corresponding column headers.
In cases like program and project hierarchies, where the child rows display similar data
to the parent rows at all levels in the hierarchy, select Suppress headers and
align columns to display the child rows aligned with their parent rows and hide the
duplicated column headings.
Step 20 Optional: Select Enable Project Switching.
When selected, Enable Project Switchingusers experience quick and easy navigation
through program and project hierarchies in a portal section. Users see the Portal
Switching icon
before the hyperlinked project type.
The
icon displays only if the record is a Capital Project record and the user has
appropriate project security permissions.
When a user clicks the
icon for a record in a non-default project, project context
switches to that record’s project.
When a user clicks the
icon for a record in a default project, project context switches
to the Company Level, if not already there.
By default, Enable Project Switching is not selected.
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Step
Metric
When the report type is Metric, the Options sub-tab presents the following options.
Step 21 See the descriptions above for Graph Y Title, Display Legend and Precision.
Step 22 Optional: Select the Tabular Output check box.
When selected, the metric chart displays as a tabular report instead of as a chart.
By default, Tabular Output is deselected.
Threshold / Scorecard Settings Section
Thresholds identify how to score metric values. Each threshold record contains values, ranges,
and colors. A threshold record can support either three ranges (for example, low, medium, and
high) or two ranges (for example, low and high).
In metric charts not based on Fact Tables, the threshold record sets the color used in the chart.
In metric charts based on Fact Tables, the threshold record defines the ranges and the count of
values that fall within the ranges.
Find Threshold definitions in the Tools menu item on the first level of the menu bar.
Select Tools>System Setup>General>Thresholds. For more information, go to the IBM TRIRIGA 10
Knowledge Center and select Administering IBM TRIRIGA>Reporting>Thresholds.
Step 1

Click the Search icon

Step 2

Select the Scorecard Category from the drop-down box.

and select the Threshold Record.

Scorecard categories organize metrics into groups for display.
Step 3

Select Low Threshold or High Threshold.
This value indicates whether the target of the metric chart is a low value or a high value.
The Scorecard Target Value can be based on any value that is set in the selected
threshold record.

Step 4

Click Save.

Related Reports Sub-Tab
A related report is a self-contained report that has its own definition and format. Its
usual purpose is to display additional information the viewer might find relevant. A
main report can have more than one related report. A related report cannot have
another related report. The system can pass values between a main report and a
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related report using shared variables. Typically, a related report contains a reference
back to the main report. You specify any related reports in the Related Reports subtab.
Step
The Related Reports sub-tab presents the following options.
Step 1

To add a related report, select Add.

Step 2

Click the Filter icon

Step 3

To restrict the reports displayed to only that report type, select a report type.

on the section bar.

The default is Report. To see all types of reports, select All.
The report types are explained elsewhere in this chapter.
Step 4

Select the Module.

Step 5

Select the check boxes of the related reports.

Step 6

Click OK.
When available, clicking a hyperlinked Name opens the definition of that report.

Step 7

To make the related report available at runtime, select Apply Filters.

Step 8

To change the sequence, click the arrows in the Order column and move a related report
up or down in the list.

Step 9

Click Save Order.

Step 10 To delete a related report, select the check box and click Remove.
Step 11 Click Save.

Security Sub-Tab
The Security sub-tab only displays in a System report when the Show as Community
Report check box is selected. The Security sub-tab defines which users have access to
the report in their Community tab. The default is for all groups to have view access,
which means that the report shows in the Community tab of every user who has
security access to the data within the report. If you add groups, only users who have
security access to the data within the report in the specified groups see the report in
the Community tab.
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To remove a report from the Community tab, deselect Show As Community Report. If
you reinstate the Show As Community Report check box, the prior settings display in
the Security sub-tab.
Step
When available, the Security sub-tab presents the following options.
Use the Add action on the Security Access section bar to grant access to groups.
Step 1

Click Add.

Step 2

Select the check boxes of the groups for access to the report.

Step 3

Click Accept.
Only members of the selected groups will see the report in their Community tab.

Step 4

To delete groups, select the groups, and click Remove.

Step 5

Click Save.

Columns Tab
The appearance and purpose of the Columns tab are different for Metric reports. This
section first describes the Columns tab for non-Metric reports, then for Metric
reports.
Non-Metric Reports
The Columns tab defines which fields will be used in the report. The information in
the Columns tab is organized into three sections. The Business Object section on the
upper left indicates the source business objects. The Columns section on the lower
left identifies which fields in the selected business object will be included in the
report. The Display Columns section on the right specifies the order in which the
selected fields will be presented and the labels used to identify them.
Step
Business Object Section
The business objects listed in the Business Object section are from the Business Objects sub-tab
in the General tab.
Step 1

Select the business object.
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Step
Columns Section
The fields displayed in the Columns section depend on the business object selected.
Step 2

Select each field to include in the report.
When you select a different business object, the fields displayed in the Columns section
change, but previously selected fields in the Display Columns section remain.

Display Columns Section
When you select a check box in the Columns section, the field appears in the list in the Display
Columns section. Clearing a check box in the Columns section removes the field from the Display
Columns list.
The Field column shows the field’s label and system name.
Step 3

To change the sequence in which the fields will display, select a field’s radio button and
click Move up, Move down, Move to top, or Move to bottom.

Step 4

To change the label that will display for a field, edit the text in the Report Labeltext
box.

Step 5

To specify a percentage of the display space for a field, specify a numerical value in the
Width text box for the field.

Step 6

To remove a field, select its radio button and click Remove.

Step 7

Click Save.

Metric Reports
For Metric reports, the Columns tab specifies how to aggregate data for this report.
Step
Aggregation Settings Section
Step 1

On the Aggregation Settings section bar, click Add.

Step 2

Specify a Label.

Step 3

Select a Function.
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Step
Step 4

To specify the order in which the aggregation setting applies when the metric report
runs, specify a Sequence number.

Step 5

To specify the field upon which the aggregation occurs, select Field1.

Step 6

For Target Axis, select either Primary Y-Axis or Secondary Y-Axis.
Target Axis identifies where the aggregated data displays. Use Secondary Y-Axis to
display a second data series next to the primary one.

Step 7

To specify a Color to represent this aggregation, click the Search icon

.

The system offers Basic and Advanced palettes from which to select the Color.
When Color is blank, the system uses the color from the user’s My Profile record. The
default for Color is blank.
Step 8

Click OK.

Step 9

Optional: Add more aggregation settings.

Step 10 To delete an aggregation setting, select the check box and click Delete.
Step 11 Click Save.

Order & Group Tab
The appearance and purpose of the Order & Group tab are different for Metric
reports. This section first describes the Order & Group tab for non-Metric reports,
then for Metric reports.
Non-Metric Reports
The Order & Group tab defines the layout of the data in the report. You can organize
the layout by group, into a specific sequence, or neither. The data, found in the left
side of the Group By and Order By sections, comes from the selections made in the
Columns tab.
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Step
Group By Section
Step 1

In the left column, select the field to Group By.

Step 2

To move the selected field to the right column, use the Move Right arrow

Step 3

To arrange the fields, use the Move Up arrow

Step 4

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.
.

.

Order By Section
Step 5

In the left column, select the field to Order By.

Step 6

To move a selected field to the right column, you can use the Ascending arrow
ascending sort or the Descending arrow

for an

for a descending sort.

Step 7

To arrange the fields, use the Move Up arrow

Step 8

To return the selection from the right column to the left column, use the Move Left
arrow

and Move Down arrow

.

.

Summary Columns Section
Step 9

If a Sum applies to your report, select a field to be summed by checking the box in the
SUM column.
Any Sum fields will have a subtotal at each Group By level. When displayed to a user, a
report containing a Summary (total) row ignores the value of the Result Size property.

Step 10 Click Save.

Metric Reports
The Order & Group tab defines the layout of the data in the metric. The information
in the Order & Group tab is organized into three sections. The Group By section
defines the fields that appear in the Group By area of the metric report and the graph
type. The Secondary Group By Properties section provides a second level of group by.
The Order By section specifies the fields by which the data will be sorted.
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Step
Group By Section
Step 1

On the Group By section bar, click Add.

Step 2

Select the Field.
Field specifies the field upon which the Group By occurs.

The system pre-populates Label from the Field definition.
Step 3

Optional: Change the Label.

Step 4

Select Hierarchy Definition.

Step 5

To specify a Root, click the Search icon

Step 6

Select the Chart Type.

Step 7

Select the Chart Template.

and select from the choices.

Chart Template specifies the specific chart within the chart type.
Find Chart Template definitions in the Tools menu item on the first level of the menu
bar. Select Tools>System Setup>General>Chart Templates. For more information, go to
the IBM TRIRIGA 10 Knowledge Center and select Administering IBM
TRIRIGA>Reporting>Creating chart templates.
The system displays a miniature representing the chart type and chart template.
The remaining fields in the Group By Properties form depend on the Chart Template that
you selected.
When the Chart Type is Bar, the standard choices for Chart Template are: Horizontal
Grouped Bar, Horizontal Stacked Bar, Vertical Grouped Bar, and Vertical
Stacked Bar.
When the Chart Type is Bar (Percent), the standard choices for Chart Template are:
Horizontal Grouped Bar (percent) and Vertical Grouped Bar (percent).
When the Chart Type is Line, the standard choices for Chart Template are: Line and Spline.
When the Chart Type is Pie, the standard choices for Chart Template are: 3D Doughnut, 3D
Pie, Doughnut, and Pie.
When the Chart Type is Circular Gauge, the standard choices for Chart Template are:
Circular Bar Gauge and Circular Gauge.
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Step
When the Chart Type is Linear Gauge, the standard choices for Chart Template are: Horizontal
Linear Bar Gauge, Horizontal Linear Tank Gauge, Vertical Linear Bar Gauge, and Vertical Linear
Tank Gauge.
When the Chart Type is Circular Gauge (Percent), the standard choices for Chart Template
are: Circular Bar Gauge (percent) and Circular Gauge (Percent).
When the Chart Type is Linear Gauge (Percent), the standard choices for Chart Template are:
Horizontal Linear Bar Gauge (percent), Horizontal Linear Tank Gauge (percent), Vertical Linear
Bar Gauge (percent), and Vertical Linear Tank Gauge (percent).
When the Chart Type is Bubble, the standard choice for Chart Template is: Bubble.
When the Chart Type is Pyramid, the standard choice for Chart Template is: Pyramid.
When the Chart Type is Line-Bar Combo, the standard choices for Chart Template are: Line /
Vertical Grouped Bar Combo and Line / Vertical Stacked Bar Combo.
Using a Bubble chart for purposes of illustration:
Step 8

If specified, the Secondary Data Source displays in the same chart as the primary data
source. Click the Search icon

to select.

The secondary data source displays in the same chart as the primary data source for
Bar, Line, and Bubble charts. For Gauge charts, the secondary data source displays as
a separate gauge next to the primary gauge. For Line-Bar Combo charts, the
secondary data source can be a different chart type than the primary data source.
Step 9

Click OK.

Step 10 When there is more than one group by, specify the Default by selecting its radio button.
Step 11 To change the sequence, click the arrows in the Order column to move a group by up or
down in the list.
By default, the group bys appear in the presentation in the same order as they appear in
the Group By section, from top to bottom.
Step 12 Click Apply Order.
Step 13 To delete a group by, select the check box and click Delete.
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Step
Secondary Group By Properties Section
Step 14 To include a Secondary Group By, first identify the Field.
Step 15 Specify an appropriate Label.
Step 16 Select the Hierarchy Definition.
Step 17 To specify a Root, click the Search icon

and make selection.

Order By Section
Step 18 Optional: Select the field to Order By.
Step 19 Optional: Move a selected field to the right column. Use the Ascending arrow
ascending sort or the Descending arrow

for an

for a descending sort.

Step 20 To arrange the fields, use the Move Up arrow

and Move Down arrow

.

Step 21 To return the selection from the right column to the left column, use the Move Left
arrow

.

Step 22 Click Save.

Filters Tab
The appearance and purpose of the Filters tab are different for Metric reports. This
section first describes the Filters tab for non-Metric reports, then for Metric reports.
Non-Metric Reports
The Filters tab uses fields, operators, and values to focus the results to display. The
information in the Filters tab is organized into four sections. The Business Object
section on the upper left indicates the source business objects. The Columns section
on the lower left identifies which fields in the selected business object to use as
filters. The User Filter Columns and System Filter Columns sections specify filters, so
that only records with fields that contain values that meet the specified criteria are
included in a report. For additional filtering, you can use the Advanced tab to filter
records based on their association with other records.
The selected filters are executed sequentially from top to bottom. Plan the sequence
ahead of time. Reports run faster if the filter that filters out the most records is
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specified first, followed by the one that filters out the next highest number of
records, and so on.
Step
Business Object Section
The business objects listed in the Business Object section are from the Business Objects sub-tab
in the General tab.
Step 1

Select the business object. The fields in the selected business object display in the
Columns section.

Columns Section
The fields displayed in the Columns section depend on the business object selected.
The columns in the Columns section are:
User: The filter value will be specified at runtime by the user. A user filter has no impact on the
total results that the user sees.
System: The filter value limits the total results that the user sees. A system filter is applied by
the system each time a report executes.
Field Label: The label for the field.
Field Name: The system name for the field.
Step 2

Select the check box in the User and System column for each field to be used as a filter.

The system adds the selected fields to the User Filter Columns section and the System Filter
Columns section.
When you select a different business object, the fields displayed in the Columns section change
but previously selected fields in the User Filter Columns section and System Filter Columns
section remain.
User Filter Columns Section and System Filter Columns Section
When you select a User check box in the Columns section, the field appears in the list in the User
Filter Columns section.
When you select a System check box in the Columns section, the field appears in the list in the
System Filter Columns section.
Clearing a check box in the Columns section removes the field from the corresponding filter
columns list.
The Field column shows the field’s label and system name.
Any time you want to see the source of a field, hover your mouse over the hyperlinked label in
the Field column.
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Step
The system applies filters sequentially from top to bottom in the list.
Step 3

To change the sequence in which the filters will apply, select a field and click Move up,
Move down, Move to top, or Move to bottom until each filter is ordered the way you
want. Organize filters so that the filters that eliminate the most records are listed first.

Step 4

To change the label that displays for a filter, edit the text in the Report Label text box.
The report labels only apply if runtime filters are used, and then only if the field is not
already displayed, or if the filter is a second runtime filter against the same field.
If the field is a Time field, the user must input the time in milliseconds or as a string in
hh:mm:ss format.

Step 5

The choices presented in the Filter Operator drop-down box depend on the field type of
the selected field. Select the desired comparison filter operator.
For more information about the available operators, see Appendix A: Filter Operators.

For system filters:
Step 6

Select the Conditional option.
If you select Yes, the system filter is ignored in the query results when the filter input is
empty.

The user provides the Value for user filters at runtime.
For system filters:
Step 7

Specify the Value that must be matched. To filter a Boolean field, use the values TRUE
or FALSE.
For more information about the special values, see Appendix B: Special Values.

For system filters:
Step 8

Select or deselect the Localize check box.
If you deselect the check box, the system filter applies the internal or non-localized
value of the localizable field.
If you select the check box, the system filter treats the localizable field in the localized
language of the user who runs the report.
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Step
You can organize system filters in sets to further refine the order in with the filters will be
applied. The join operator provides one layer of grouping.
Step 9

Select the Join Operator. For the first field, the choices are blank and NOT. For
subsequent fields, the choices are AND, OR, AND NOT, and OR NOT.

Another layer of system filter grouping comes from the column to the right of the Join Operator
column and the column to the right of the Value column. Together they provide the ability to
define sets of filters. The filters in each group are applied as a unit before joining their result
with the rest of the filters.
You can organize groups within groups. The innermost group will be applied first, all the way up
to the outermost group.
Step 10 To organize nested filters use the selections in the numbered drop-down.
Step 11 Click Save.
If your filter groups are uneven, the system displays an error message and does not apply
your changes. See the example in Appendix D: Example of User Filters and System
Filters.
Step 12 To copy an existing filter and create one with the same source, select the filter item and
click Copy. A new identical row appears below the copied row.
The copy of a User filter appears in the User Filter Columns section. The copy of a
System filter appears in the System Filter Columns section. The system clears any
groupings in the System Filter Columns section.
Step 13 Adjust the values in the filter properties, as described above.
Step 14 To remove a row, select the row and click Remove.
If you click Remove and this is the only row that refers to a field in the Columns section,
the system clears the field’s check box in the Columns section.
If you clear the check box in the Columns section, the system removes all rows in both
filter columns sections that refer to that field.
Step 15 Click Save.
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Metric Reports
The Filters tab uses fields, operators, and values to reduce the search results to
display. The entries in the Filter section define the filters applied at runtime.
The selected filters execute sequentially, from top to bottom. Plan the sequence
ahead of time. Reports run faster if the filter that filters out the most records is
specified first, followed by the one that filters out the next highest number of
records, and so on.
Step
Step 1

Click Add.

Step 2

To specify the field to use as the filter, select Field.
The system displays fields in SectionName::FieldName format.

Step 3

Optional: Change the Label for your report.

Step 4

Select the Hierarchy Definition.

Step 5

To specify a Root, click the Search icon

Step 6

Select the comparison filter operator.

and make a selection.

For more information about the available operators, see Appendix A: Filter Operators.
Step 7

Specify the Value.
The user specifies the filter Value at runtime. For more information about the special
values, see Appendix B: Special Values.

Step 8

Click OK.

Step 9

To change the sequence, click the arrows in the Order column and move a filter up or
down in the list.

Step 10 Click Apply Order.
Step 11 To delete a filter, select the check box and click Delete.
Step 12 Click Save.
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Advanced Tab
Using the Advanced tab, you can filter records based on their association with other
records and to specify actions that users can perform on records from the
presentation. Actions specified on this tab appear at the top of the presentation,
along with any built-in actions.



Note – For system reports which are editable queries, the Import State Actions button is
available and imports state family actions for use in the Actions section.



Note –Only administrative userswill be able to add actions to a System Report. Non-admin
users will receive a Security Warning messagestating that they do not have permission to
access the page.

For additional filtering, use the Filters tab to target the search results displayed using
fields, operators, and values.
Step
Metric reports include the Validate action on the Advanced tab. You use Validate to debug the
construction of your metric report.
Association Filters Section
Step 1

On the Association Filters section bar, click Add.
The system displays the Add Associations form where you can define the type of
associated records by which you want to filter the results of the report.
To avoid potential report performance issues, avoid using –Any- for the module
selection and All for the business object selection whenever possible.

Step 2

Select the Module. If it is necessary to include all modules, select –Any-.

Step 3

Select the Business Object. If it is necessary to include all business objects in the
selected module, select All.
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Step
Step 4

From the drop-down box, select the Association Type. This is the association type
defined from the perspective of the filtering module and business object specified
immediately above. To include all association types, select ALL.

Step 5

All new reports will have aReverse Association set toNo. If an existing report has a
Reverse Association set to Yes, a warning message will display. If a report used in the
association filter down the line has a Reverse Association set to Yes, a warning message
will display. To remove the warning message, set the Reverse Association to No.
It is no longer possible to set the Reverse AssociationFlag. Only existing reports with the
flag set will be able to show the flag in the association filter. When the Reverse
Association is set to No, it is not possible to set it back to Yes.

Step 6

To specify which records to use to filter the result set of the report or query for which
the association filter is defined, use the Filter Type and Record / Query fields.
A specific filtering record can be specified through the use of special name values.
Multiple filtering records can be specified by choosing Query in the Filter Type field and
then choosing a query that returns the desired filtering records in the Record / Query
field. For more information about both of these fields, see Appendix C: Special Names in
Record Field, and the Application Building for the IBM TRIRIGA Application Platform 3
book.

Step 7

Click OK.

Step 8

To delete an association filter, select the check box of the items to delete and click
Delete.

Actions Section
Users can perform the actions specified in the Actions Section directly on records from the report.
Step 9

On the Actions section bar, click Add.

Step 10 Select the Action Type:


System Add - Creates a new record that is the same type of record as the selected
records in the presentation.



System Delete - Deletes the selected records in the presentation.



Custom - Allows actions that are related to the records in the presentation.



Query - Allows searches related to the records in the presentation.

Action Type = System Add
Step 11 If the Action Type is System Add, specify the internal Name of the action.
Step 12 Specify the presentation Label of the action.
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Step
Step 13 If the System Add action requires a secondary action by the user, select Secondary
Action.
A Secondary Action requires the user to select a second action after the primary one.
Examples of secondary actions are OK and Accept.
Step 14 Click OK.
Action Type = System Delete
Step 15 If the Action Type is System Delete, specify the internal Name of the action.
Step 16 Specify the presentation Label of the action.
Step 17 If the System Delete action requires a secondary action by the user, select the
Secondary Action check box.
A Secondary Action requires the user to select a second action after the primary one.
Examples of secondary actions are OK and Accept.
Step 18 Click OK.
Action Type = Custom
Step 19 If the Action Type is Custom, specify the internal Name of the action.
Step 20 Specify the presentation Label of the action.
Step 21 Select the Module and Form to identify a form.
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Step
When the Action Type is Custom and the specified action is performed, the system creates a new
record of the type that is edited by the form. The physical creation of the record is followed by
these optional activities in this order:
Association Type - If a value is specified for Association Type, an association with the
specified name is created from the new record to selected records in the presentation.
Pre-Create Workflow - If a value is specified for Pre-Create Workflow, the specified
workflow runs before the new record opens. This overrides the pre-create workflow set in
the Data Modeler.
Popup - If the Popup check box is checked, the specified form pops up, so that someone can
edit the new record and perform actions on it.
Secondary Action – If the Secondary Action check box is checked, the action requires the
user to perform an additional action, such as OK or Accept.
Step 22 Click OK.
The label for the Form field is a hyperlink. Clicking it opens the Form Builder for editing the
selected form. The label for the Pre-Create Workflow field is also a hyperlink. Clicking it
opens the Workflow Editor for editing the selected workflow.
Action Type = Query
Step 23 If the Action Type is Query, specify the internal Name of the action.
The label for the Query field is a hyperlink. Clicking it opens the Report Builder for
editing the selected query. Specify the presentation Label of the action.
Step 24 Select the Module and Query to identify a query.
For module-level queries, make sure that the business object fields referenced in the
query are fields that are common to all business objects queried from the module.
Step 25 Click OK.
Step 26 To change the sequence, click the arrows in the Order column and move an action up or
down in the list.
By default, the actions appear in the report’s presentation in the same order as they
appear in this list, from top to bottom.
Step 27 To edit an action, click the hyperlink in the Action column to open the definition of the
item.
Step 28 To delete an action, select the check box and click Delete.
Step 29 Click Apply.
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Step
Step 30 Click Save.

Where Used Tab
The Where Used tab shows what references or uses the report. The Where Used tab
has two sections: Other Usage, and Workflows.
The fields displayed in the Other Usage section are: Name, Type, Module, Object, Action, Form, and
Additional Information.

The fields displayed in the Workflows section are: Name, Revision, Object, Action,
Status, Task, Type, and Usage. The workflows listed reference this query in a Query
task. The Status, Type, and Usage columns have filters to refine the displayed
information.
If you want to export the information in the Where Used tab, click the Export Usage
action. You can save or open a .csv file. Clicking the linked object opens the builder
for the reference for most object types.
The following table lists the references found by Where Used.
Type
Business Object Field

References


Query (Display Columns, Order By, Group By, Sum, Filter)



Smart Sections



Locator



Form



Regular Formulas



Extended Formulas



Workflow Create Record Task (Map – Field, Source or Target)*



Workflow Modify Records Task (Map – Field, Source or Target)*



Workflow Schedule Task (Map – Field, Source or Target)*



Workflow Conditions - Start Task, Switch Task, Break Task*



Workflow Retrieve Records Task (Filter)*



Workflow Create Record/Modify Records/Schedule Tasks (Map –
Field as part of Expression)*



Workflow Populate File Task*



Workflow Distill File Task*



Workflow Variable Assignment Task (Value is from an
expression)*
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Type
Form

Query

Workflow

References


Form Field Action



Form Section Action - Popup Form, non Popup Form



Portal Section, Record Add



Navigation Item (Master Detail Report, Record Add, Master Detail
Default)



Navigation Item Action



Navigation Item Security Override



Query



Query Action



Workflow Modify Metadata Task*



Workflow Create Task*



State Transitions (Form)



System Add



System Delete



Form Section Find Action



Form Field Action (onClick, onChange)



Form Popup Section Action



Form Query Section (Query, Availability, Availability Legacy,
Calendar, Gantt, Group By)



Portal Section Query



Scorecard



Navigation Item (Master Detail Report, Record Open, Report,
Master Detail Hierarchy, Scorecard)



Navigation Item Dynamic Labels



Navigation Item Security Override



Query Action



Query in a Sub Report



Query in an Associated Query (Hierarchical Query)



Query Association Filters



Workflow Query Task*



Extended Formulas



Query Action (Pre-Create Workflow)



Form Field Action



Form Field Action (Pre Form and Post Form Workflows)



Form Section Action (Pre Form and Workflow)



Form Section (Select and Stack Pre-Move)



Form Section (Synchronous and Stack On-Save)



Form (Pre-Load Workflow)



State Transition (BO Sub Action - Workflow Select)
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Type

References


BO (Pre-Create Workflow)



Smart Section (Initialize Record)



Call Workflow*



Portal Section, Record Add



Navigation Item (Record Add)



Navigation Item Action



Navigation Item Security Override

* Workflow references (marked by an asterisk (*) above) note the
latest workflow version containing the reference. The system checks
workflows in the following statuses: Revision In Progress, Retired,
Published and In Progress.

Administration
The Administration tab of the Report Manager contains all the reports in all My
Reports tabs in the system. Most installations restrict access to the Administration tab
to system administrators.
You may not have access to the Administration tab. If you have access to the
Administration tab, your view may be different from that described in this user guide.
Depending on your system security, you may see some or all of the features.
The column headings displayed in the Administration tab follow. To open the Report
Builder definition of a report, click the hyperlink. Use the filters in the column
headings to find the report of interest.
Column Heading

Description

Blank

Displays the Run Report icon . When you click the icon, the system
generates the report and displays it in a separate window.

Title

The title of the report.

Name

The system name of the report.

Tag

A name that can be filtered from the Report Manager. Use this field
to build collections of related reports.

Form

The display for the report. If it is a module- or business object-level
report, this field shows a comma-separated list of the forms.
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Column Heading

Description

Display Type

The type of report. Values include –All-, Report, Graphic,
Summary, Chart, Hierarchy, and Metric.

Owner

The user who built the report.

Shared Groups

Lists the groups with which the report is shared.

The actions available on the Administration tab in the Report Manager follow.
Action Name

Description

Change Owner

Changes the owner of the selected reports from one user to another.

Copy

Makes a copy of a selected report and pastes the copy into the
Administration tab. The copied version has the words “Copy of” at
the beginning of the Name. To copy a report, select the check box
and click Copy.

Delete

Removes the selected report permanently from the Report Manager.
To delete a report, select the check box and click Delete. In the
delete confirmation window, click OK.

Share Report

Changes the shared groups of the selected reports.

Change Owner
To change the owner of one or more reports:
Step
Step 1

Select the check boxes of the reports to move to a different owner.

Step 2

Click Change Owner.

Step 3

Select the user who is the new owner of the report.

Step 4

Click OK.
Unless the prior owner is a member of a shared group for the reports, the system
removes the reports from the prior owner’s My Reports.
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Share Report
Follow these steps to share one or more reports with one or more groups.
Step
Step 1

Select the check boxes of the reports to share.

Step 2

Click Share Report.

Step 3

Select the check boxes of the groups to have access to the report.

Step 4

Click Accept.
Each group receives View security access to the reports.
The change reflects in the Shared Groups column in the Administration tab.
The system adds the reports to the My Reports tab of all members of the shared groups.

To grant more than View security access to a shared group, or to remove a shared group:
Step 5

Click the hyperlinked name of a report.

Step 6

Select the Security sub-tab.

Step 7

Adjust the security access. For more information, read about the Security sub-tab
elsewhere in this guide.

Step 8

Click Save & Close.

Exporting a Report
You can export the report only after it displays in the Report window. You can export
the report to a specific file format (such as a Microsoft Excel spreadsheet or Microsoft
Word document).
Step
Step 1

Click the Export icon

Step 2

Select the File Format.

Step 3

The choices in Page Range depend on the file format selected. Select either All Pages
or Select Pages to specify the specific page numbers.

Step 4

Click Export.

in the upper left corner of the report.
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Step
Step 5

To immediately open the file, click Open.
The report displays in the appropriate viewer or application.

Step 6

To save the file to a specific location, click Save.
Select the location to which the file will be saved.



Note – If you experience display issues with the Adobe PDF option, you might need to
download and install the correct font package from adobe.com.

Generating a Form Report
The TRIRIGA Application Platform can produce a different type of report that contains
the contents of a single record, including the contents of its multi-record smart
sections. This type of report is called a form report.

HTML and BIRT Form Reports
Form reports are available in a record’s Reportstab. The platform provides the data
while HTML or BIRT is used to provide the presentation.
This section focuses on HTML form reports. For more information about BIRT form
reports, see the IBM TRIRIGA Advanced Reporting chapter.
The contents of a form report are based on the contents of a record in a business
object. If an HTML form report is to include rows of data from associated records, the
business object must have a multi-record smart section from which the form report
can take the rows of data. HTML form reports cannot take data from query sections.
However, BIRT can display data from query sections.
The steps to configure an HTML form report follow:


Download Form Template



Format Form Template



Install Form Template



Present Form Template
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Download Form Template
Begin by navigating to the Form Builder and selecting the form on which to base the
form report. Follow these steps in the Form Wizard:
Step
To select the form, specify the fields and download the form template:
Step 1

From the Form Builder, select the form on which to base the form report.

Step 2

On the Layout tab of the form, click Report Header.

Step 3

Select the fields you want to include.
Use the Export form to select the fields you want to include in the form report. The
Export form has a check box for every field in every section of the business object,
except query sections.
For a smart section, it also contains every section and field of the business object
associated with the smart section.

Step 4

To rearrange the fields, use the Move Up arrow

Step 5

To download the HTML form template, click Export.

Step 6

Save the file.

and Move Down arrow

.

Even though the HTML form template you download from the TRIRIGA Application
Platform has a .doc extension, it is actually an HTML file. You could change the file
extension from .doc to .html when you save the file.
Open and edit the file with an HTML editor. For example, you could use Word or Excel.
If you use Word or Excel, be sure to save the file in web page format or HTML format. If
you save the file as a Word or Excel file, the IBM TRIRIGA Application Platform cannot
generate a form report from it.

Format Form Template
The downloaded file is a template for a form report containing data tokens that
represent the fields you selected. At this point, you can use most HTML formatting
tags to control the appearance of this report.
After you edit the HTML form template and install the edited template in the TRIRIGA
Application Platform, the platform uses the template to generate a form report by
substituting actual data values in place of the data tokens.
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Step
Step 1

Open the file with your HTML editor.
Within the raw HTML is a data token that corresponds to each field. The data token
begins and ends with two percent (%%) signs.
You use the data tokens to identify where in the form report the value for a particular
field should appear.
The Export window does not provide a way to generate a data token for a number field’s
unit of measure. You can create such a data token yourself by adding _uom to the text of
the number field’s data token. For example, if a number field’s data token is
%%General_Count%%, the data token for the number field’s unit of measure is
%%General_Count_uom%%.

Step 2

Using most standard HTML tags, add surrounding text and formatting so that when the
TRIRIGA Application Platform does its substitution, it looks like the form report you
want.

Step 3

You can format data tokens that correspond to fields in a General section or in singlerecord smart sections in any way that you prefer.
There is a rule regarding what works for data tokens that correspond to fields in multirecord smart sections. Data tokens that correspond to fields in the same multi-record
smart section should be in the same row of the same table but each one in a different
column. This is because the TRIRIGA Application Platform will provide as many different
substitutions for these data tokens as there are records in a smart section. If you do not
follow the rule, it is likely that the form report will not look the way you intended.

Step 4

Save the file with an .html extension.

Next, you need to install the edited form template in the IBM TRIRIGA environment.
There are two parts to this installation:


Install Form Template – Bring your HTML template file into the IBM TRIRIGA
environment using the Document Manager.



Present Form Template – Arrange for your file to be use as a template for your
records.

Install Form Template
After editing your form template, use the Document Manager to place the template
file in the IBM TRIRIGA environment. The Document Manager is described more
completely in the IBM TRIRIGA 10Knowledge CenterunderManaging documents.
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The following procedure provides an example based on an application named
“Facilities Management”.
Step
To prepare the folders and install the template file using the Document Manager:
Step 1

Open the Document Manager.
If you have not previously used the Document Manager to manage any files related to
your application (for example, a Facilities Management application), folders related to
Facilities Management will not be present, and you must create them.
In the Document Manager, there must be a folder (for example, Facilities Management)
under the root folder for each application.
If the only files that the Facilities Management application will have are templates for its
form reports, name the folder the same as the name of the application followed by the
word “Forms” (for example, Facilities Management Forms).
Otherwise, create a folder with the same name as the application (Facilities
Management) and a separate sub-folder (Facilities Management Forms) for the form
report templates.

Step 2

Step 3

If there is no folder for your application, create one:


Select the Document Management folder.



Select New Folder.



Specify a Name (for example, Facilities Management) and (optional) description for
the folder.



Click Create.



Click Save & Close.

To create a sub-folder:


In the left pane, select the Facilities Management folder.



Click New Folder.



Specify a Name (for example, Facilities Management Forms) and (optional)
description for the folder.



Click Create.



Click Save & Close.

Step 4

Expand the Facilities Management folder.

Step 5

Click the Facilities Management Forms folder to select it.

Step 6

Select New Document.
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Step
Step 7

Optional: Specify a name, number, description, and comment for the document.

Step 8

Click Browse to locate and select your HTML template file.

Step 9

Click Upload to upload the file to the IBM TRIRIGA Application Platform environment.

Step 10 When the upload process completes, click OK.
Step 11 In the right pane of the Document Manager, select the hyperlinked name of the file to
edit its properties.
Step 12 Select the Description tab.
Step 13 In the Description tab, select the Report check box.
Step 14 Click Publish.

Present Form Template
There are three ways to make a form report template file available as a form report.
The form report can be presented: 1) in its own tab, 2) in a report section of a form,
or 3) embedded in an email. This section focuses on a form report presented in its
own tab. For information about report sections or email, see the Application Building
for the IBM TRIRIGA Application Platform 3 book.
To make a form report template file available as a form report in its own tab, you
must do two things:


Ensure that a form used to edit the records has a Reports tab.



Associate the template file with the Reports tab.

Begin by navigating to the Form Builder and selecting the form on which the form
report is based. This causes the Form Wizard to open. The following procedure uses a
form named Facilities. The edits you need to make are on the Layout tab.
Step
To make a form report template file available as a form report in its own tab:
Step 1

From the Form Builder, select the form (for example, Facilities) on which the form
report is based.

Step 2

In the Layout tab, if the form is not in an editable state, click Revise.

Step 3

In the Navigation panel, select the form name (for example, Facilities) at the root of the
tree.
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Step
Step 4

In the Properties panel, to cause the form to display a Reports tab, select Show Reports.

Step 5

Click Apply.

To associate the form report template with the Reports tab:
Step 6

Select the Includes/Forms tab.

Step 7

On the Forms section bar, click Add to add.

Step 8

Search for and select your form report template (for example, Facilities).

Step 9

Click OK.

Step 10 Optional: Specify the Label to use to select the template.
If there is more than one template listed in the Forms section, when a user views the
Reports tab of the form, the user first sees a list from which to select a template. The
labels specified for the templates are what appear in this list. If only one template
displays in the section, when a user views the Reports tab of the form, the user
immediately sees the form report based on the template.
Step 11 Return to the Layout tab and click Publish.

© Copyright IBM Corporation 2011, 2015.

119

3. IBM TRIRIGA Advanced Reporting
If you need a report presentation that is beyond the capabilities of the IBM TRIRIGA
Report Manager, you can use the IBM TRIRIGA Advanced Reporting feature. This
feature uses the Eclipse BIRT application as its enabling technology, and an IBM
TRIRIGA plug-in for the BIRT application.
There are two different types of advanced reports: form reports and query reports.
Form reports most often display the contents of a single record. Query reports most
often display multi-record reports. You can use the IBM TRIRIGA Advanced Reporting
feature to create form reports as well as query reports.
The BIRT application is a popular, open-source reporting tool that offers rapid report
development and has powerful formatting capabilities. The BIRT application layout is
grid-based, and every element must exist in an element of the BIRT layout grid. Grid
layouts automate the tasks of aligning report elements onto lines, aligning elements
vertically into columns, and sizing the columns to fit the contents. Grids also make it
easy to create a report by dragging elements into the report design.
Before you can develop BIRT reports for an IBM TRIRIGA application, you must install
the BIRT Report Designer and configure it to work with IBM TRIRIGA.

Install the BIRT Application
You need to install the BIRT Report Designer only once on a report writer’s computer.
Before you begin the installation, ensure that a supported version of the Java JRE is
installed locally. For the supported versions, see the Client Compatibility section of
the IBM TRIRIGA Support Matrix:
https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/IBM+
TRIRIGA1/page/Client+Compatibility
To install the BIRT Report Designer:
Step 1

Go to BIRT 4.3.1 in the IBM Integrated Service Management (ISM)
library website:
http://www.ibm.com/software/ismlibrary?NavCode=1TW10MA5K.

Step 2

Download the BIRT Report Designer - All-in-One version to a local directory.
The directory name cannot include any spaces

Step 3

In the folder where you downloaded BIRT, unzip the birt-reportdesigner-all-in-one-4_3_1.zip file, open the Eclipse folder, and
double-click the eclipse.exe file.
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Step 4

Select the Workplace location where Eclipse will store your project files and
information and click OK.

Configure a BIRT Process Server
You can specify that BIRT reports be offloaded and processed by a separate BIRT process server, which
is a second IBM TRIRIGA server that you configure as the BIRT process server. If you do not configure a
separate process server, the BIRT report processing is done on the application server.
To designate an IBM TRIRIGA server as a BIRT process server:
Step 1

Locate the TRIRIGAWEB.properties file.

Step 2

Set the BIRT_PROCESS_SERVER_LISTENING_PORT property to the TCP port
that will handle the communication that occurs between the two IBM TRIRIGA
servers. The server listens for BIRT requests on this port.
For example, BIRT_PROCESS_SERVER_LISTENING_PORT=47074
By default, this property value is blank, which means that all processing is
done on the application server.

Step 3

Set the BIRT_PROCESS_SERVER_HOST_NAME property to the host name or IP
address of the BIRT process server.
For example,
BIRT_PROCESS_SERVER_HOST_NAME=BIRTProcessServerHostName.
By default, this property value is blank, which means that all processing is
done on the application server.

Step 4

Set the BIRT_PROCESS_SERVER_PORT property to the listening port that you
configured on the BIRT process server.
For example, BIRT_PROCESS_SERVER_PORT=47074.
By default, this property value is blank, which means that all processing is
done on the application server.

Step 5

Save the TRIRIGAWEB.properties file.

Step 6

Restart the BIRT process server.

Install the IBM TRIRIGA Plug-In
You need to install the IBM TRIRIGA plug-in for BIRT on a report writer’s computer.
To install the plug-in:
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Step 1

Open the BIRT application, and navigate to Help > Install New Software.

Step 2

In the Work With field, specify the URL to the IBM TRIRIGA plug-in software
site:
http://[server:port]/[context
path]/eclipse,
where
[context path] is required only if the server is configured with a context
path.

Step 3

Select IBM TRIRIGA BIRT Features.

Step 4

Select the Details.

Step 5

Click Next.

Step 6

Review the Install Details and click Next.

Step 7

Review and accept the licenses, and click Finish.

Step 8

When prompted, restart the BIRT application.

Step 9

In the Workspace field, select the workspace and click OK.

Step 10 When the Eclipse application opens, select Window > Preferences and select

IBM TRIRIGA BIRT Preferences.
Step 11 Specify the information for connection to the IBM TRIRIGA server:



IBM TRIRIGA App Server: Path used for communication to the IBM TRIRIGA
Application Server, in the format http://[server:port]/[context
path]/remote, where [context path] is required only if the server is
configured with a context path.



Username: User name to access the IBM TRIRIGA Application Server.



Password: Password to access the IBM TRIRIGA Application Server.



Project ID: [Optional] Project ID to specify that the system runs reports in a
particular project context. This specification can be useful when you
perform BIRT-Eclipse previews for Active Project query reports.

Step 12 Click Test Connection.
Step 13 In the Connected dialog box, click OK.
Step 14 Click OK.
Step 15 To have BIRT notify you of updates, select Windows > Preferences.
Step 16 Expand the Install/Update folder, and select Automatic Updates.
Step 17 In the right pane, select Automatically Find New Updates and Notify Me.
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Step 18 Select the Update Schedule, Download Options, and When Updates are Found

options.
Step 19 Click Apply, and click Update.

Upgrade the IBM TRIRIGA Plug-In
When a new IBM TRIRIGA release is available, you need to update the IBM TRIRIGA
plug-in inside the BIRT Eclipse environment. You need to install the IBM TRIRIGA plugin for BIRT on a report writer’s computer.
To upgrade the plug-in:
Step 1

Open the BIRT application, and navigate to Help -> About Eclipse.

Step 2

Select About Eclipse.

Step 3

Click Installation Details.

Step 4

In the Installed Software tab, select IBM TRIRIGA BIRT Feature.

Step 5

Click Update.

Report Writer Flow
The typical steps that a report writer takes to develop and deploy an IBM TRIRIGA
BIRT report include:
Step 1

Create a starter report in IBM TRIRIGA.

Step 2

Import a starter report to the BIRT Report Designer.

Step 3

Develop a BIRT report.

Step 4

Preview a BIRT report.

Step 5

Export a BIRT report.

Step 6

Upload a BIRT report to IBM TRIRIGA.

Step 7

Associate the BIRT report to an IBM TRIRIGA access point.

Create a Starter Report in IBM TRIRIGA
You download the starter report files from the IBM TRIRIGA application. These files
contain an entire starter report, not just data sources. You model a new report from
either an existing IBM TRIRIGA Report/Query or an IBM TRIRIGA Form.
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Create a Starter Report from an IBM TRIRIGA Query Report
You can create a starter report by modeling it from a new or existing IBM TRIRIGA
query report.
Query reports can contain data from any number of top-level records. They can also
contain multiple levels of detail that are accessible through associated business
objects and records. Most often, query reports display multi-record reports.
To create a starter report:
Step 1

In the IBM TRIRIGA Report Manager, navigate to the report or query to use as a
model.

Step 2

Select the Advanced tab.

Step 3

Select the BIRT Report link.

Step 4

At the prompt, click Save.

Step 5

Select the starter file download location and click Save.
The zipped starter report file contains the following files:


The starter report design. This file has an extension of .rptdesign.



Labels that you can use in the report. This file has an extension of
.tririgalabels.properties.

Create a Starter Report from an IBM TRIRIGA Form
You can create a starter report by modeling it from a new or existing IBM TRIRIGA
form.
Form reports typically contain data from one top-level record. They may contain data
from one or more associated records. Users can select form reports in a record’s
Reports tab.
You can also run a form report to display the form for multiple top-level records. This
is called a bulk report.
To create a starter report from an existing form:
Step 1

In the IBM TRIRIGA Form Builder, select the Layout tab.

Step 2

Select the BIRT Report link.

Step 3

At the prompt, click Save.
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Step 4

Select the starter file download location and click Save.
The zipped file contains the following files:


The starter report. This file has an extension of .rptdesign.



Labels that you can use in the report. This file has an extension of
.tririgalabels.properties.

Import the Starter Report into BIRT
You import the starter report from IBM TRIRIGA into the BIRT Report Designer (Report
Design window). As an alternative to the following procedure, if your zip extraction
tool allows it, you can open the .zip file directly and drag the files into a particular
report project in the BIRT Report Designer’s Navigator pane.
To import the starter report into BIRT:
Step 1

In BIRT, you need a report project to use for this starter report.


If you already have a report project to use for this report, go to Step 2.



To create a report project:
o Select File > New > Project.
o Expand the Business Intelligence folder, select Report Project and click
Next.
o Specify a project name and click Finish.

Step 2

In the Report Design window, select the Navigator tab.

Step 3

Right-click the project and select Import.

Step 4

Expand the General folder, select Archive File, and click Next.

Step 5

Select the .zip file that you downloaded in the Create a Starter Report in IBM
TRIRIGA section, and click Finish.

Step 6

Verify that the starter report displays in the Navigator tab.
An imported starter report contains the following:


One data source



One or more data sets



Zero or more data set parameters for each data set



Zero or more report parameters, each one corresponding to a data set
parameter



Link to the tririgalabels.properties file in the Report Layout
Resource section of the Report Designer
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Develop a Report in BIRT
To develop a BIRT report, you use the BIRT Report Designer to modify the imported
.rptdesign file. The BIRT design specifics are beyond the scope of this guide. For
detailed information about developing a BIRT report, see the Eclipse – BIRT
documentation.
When you develop a report in BIRT, be aware of the following IBM TRIRIGA/BIRTspecific information.

Data Source
All data access in a BIRT report is through data sources. A starter report includes a single data source
named TRIRIGA. TRIRIGA is a scripted data source and all data sets that obtain their data from an IBM
TRIRIGA server need to use this data source. Use this data source as much as possible for all your data
access because it goes through the IBM TRIRIGA meta-layer and includes built-in business logic around
security and other features.

If the TRIRIGA data source does not provide all the needed data, you can use any of
the data access methods that BIRT supports, including JDBC and XML. For direct
database access to the TRIRIGA database, you can use a JDBC data source. You must
add this data source manually, and it must be named TRIRIGA_DB. By naming it
TRIRIGA_DB, at runtime the IBM TRIRIGA Platform dynamically modifies the report so
that it interacts with the IBM TRIRIGA database associated to the server within which
the report is running.
To connect to a database:
Step 1

In BIRT, select the Data Explorer tab.

Step 2

Right-Click the Data Sources and click New Data Source.

Step 3

Select JDBC Data Source.

Step 4

In the Data Source Name field, specify TRIRIGA_DB. The value “TRIRIGA_DB” is
required.

Step 5

Click Next.

Step 6

Optional: Select the Driver Class.

Step 7

Specify the Database URL, User Name, and Password.

Step 8

In the JNDI URL field, specify jdbc/local/Datasource-TRIRIGA-data.

Step 9

Click Finish.

Step 10 In the left pane, right-click Data Sets, and click the new data set name.
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Step 11 Specify the SQL statement.
Step 12 Optional: Add the parameters.
Step 13 Click Finish.

Data Sets
A starter report contains at least one data set. This data set models the IBM TRIRIGA
report or form from which the BIRT Report was originally created. The name of the
data set is encoded to represent the IBM TRIRIGA report or form. For example, a data
set that models the report triFiscalPeriods_-_Find_-_Years is named
[v2QRY]Classification_triFiscalPeriods_
triFiscalPeriods_-_Find_-_Years.
Query Reports
A starter report exported from an IBM TRIRIGA query has exactly one data set. This
data set has columns that correspond to display columns in the IBM TRIRIGA query.
For example, the IBM TRIRIGA report triFiscalPeriods - Find -Years queries has a
particular set of display columns (Name, Start Date, End Date, and Hierarchy Path), so
the data set in the starter report has those fields exposed as output columns of the
data set.
Form Reports
A starter report exported from an IBM TRIRIGA form can have multiple data sets.
Exactly one data set exists in the starter report with a prefix of [v2BO]. This data set
represents the top-level data of the form and has columns corresponding to the
business object fields for the form's top-level business object. The built-in
system__recordIds input parameter controls the records to retrieve.
Every Smart Section in the form's business object is represented as a data set with a
prefix of [v2SS]. These Smart Section data sets have columns that correspond to the
business object fields in those sections. The built-in system__parentRecordId
input parameter controls the data to retrieve for this data set.
Every Query Section in the form is represented as a normal query data set with a
prefix of [v2QRY]. The built-in system__parentRecordId input parameter
controls the data to retrieve for this data set.
In the starter report, the system__parentRecordId input parameters are not
bound to the top-level business object data set. You must bind the parameters inside
the report layout. For more information, see the Subreports section.
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Organization Access

To present data in a report from the system's root organization record, you can use
the BIRT custom function named getRootOrganizationId(). This function returns
the ID of the root organization. You can pass the value to the system__recordIds
input parameter of an organization business object data set.
Project Access

To present data in a report for a Capital Project that a particular record resides
within, you can use the BIRT custom function named getProjectIdForRecord().
When provided with a particular record ID, this function returns the ID of the Capital
Project that the record resides within. If the result is NULL, it indicates that the
record is at the Company Level, not in a Capital Project. You can pass a non-null
result value to the system__recordIds input parameter of a project business
object data set.
Event Handler
In a starter report, every IBM TRIRIGA-BIRT Data Set has an event handler named
com.tririga.platform.birt.dataset.TriDataSetEventHandler. All IBM
TRIRIGA BIRT data sets require this event handler, which has the code needed to
retrieve the data at runtime. Do not change the event handler.
Performance Consideration
If you need data from multiple business objects, join the business objects into a single
multi-business-object IBM TRIRIGA query rather than using BIRT to join the results of
multiple IBM TRIRIGA queries.

Data Types
To preserve IBM TRIRIGA data in its most useful form, the system returns all business
object field data from IBM TRIRIGA in the form of Java Objects.
IBM TRIRIGA data types include the following:
DateTime Example:
IBM TRIRIGA has a built-in approach to format date time strings by looking at the date
time mask in the current user's profile record. By returning IBM TRIRIGA DateTime to
BIRT as a Java object, IBM TRIRIGA makes both elements (the native DateTime and
the preferred format of an IBM TRIRIGA DateTime) available to you. This provides a
reasonable default behavior of displaying the DateTime according to the IBM TRIRIGA
user preferences and allows you access to the native DateTime object in the event
you need to work with the DateTime in a more structured way (for example, group by
Year).
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Number Example:
Most IBM TRIRIGA numbers have unit of measures associated to them and the IBM TRIRIGA unit-ofmeasure definition metadata specifies how to display a number of each type. By returning an IBM
TRIRIGA Number to BIRT as a Java Object, IBM TRIRIGA makes both elements (the native BigDecimal
and the IBM TRIRIGA-suggested display format) of an IBM TRIRIGA Number available to you. This
provides a reasonable default behavior of displaying the Number in the IBM TRIRIGA-configured format
and allows youaccess to the native BigDecimal object in the event that you need to work with the value
in a more structured way (for example, sum all the values).

Java Objects
All starter reports have all of the output columns modeled as Java Objects. Using Java
objects as the data types for IBM TRIRIGA data provides you with increased flexibility
in developing reports.
When you use Java objects, keep the following in mind:


When you look at a data set in the BIRT Report Designer, you cannot look at the
Type column to see the data type.



When you use a native value in the report, you need to know the BIRT Type to
map it to.



Frequently use of native values requires more scripting.

When you drag an IBM TRIRIGA element directly onto a report, the element displays in
the report.
To use the output column for something other than display, you can:


Access the output column's native SQL value in any BIRT expression by using the
object's getNativeValue() method. For example, in the Expression Builder,
you
can
type
row[“Classification_triFiscalPeriods_triStartDA”].getNative
Value().



If the Java object has additional methods, you can access them by using any
BIRT expression. When binding one of these expressions results to a report
element, select the appropriate BIRT native type in order to access all the
built-in BIRT functionality.

When you put the output column on the report, BIRT automatically calls the
toString() method and renders the result. To access the native value, you need to
write a minor script like the following:
row[“Classification_triFiscalPeriods_triStartDA”].getNativeValue
().
When you export a starter report, all data is mapped to Java Objects inside BIRT.
Every Java Object minimally has the getNativeValue() and toString() methods.
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The following table provides information for additional methods, by business object
field type.
Business
Object Field
Type

getNativeValue()
Result

Considerations for
toString()

Additional
Methods

Suggested
BIRT
Binding if
Native
Value
Used

Text

java.lang.String

N/A

N/A

String

Number

java.math.BigDecimal

UOM metadata and BO
Field masks

getUom().getUom
TypeCode()

Decimal

Financial
Rollup

getUom.getUom
Value()
hasUom() returns
false if there is no
UOM.

Classification
Rollup

java.math.BigDecimal

BO Field masks

N/A

Decimal

Date

java.sql.Date

User's timezone and
preferred display format

N/A

Date

DateTime

java.sql.Date

User's timezone and
preferred display format

N/A

Date Time

Time

java.sql.Time

Displays as
hours/minutes/seconds
with no timezone
considerations (more like
a duration than a SQL
time).

N/A

Time

N/A

N/A

Locator

java.lang.String
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Business
Object Field
Type

getNativeValue()
Result

Considerations for
toString()

Additional
Methods

Suggested
BIRT
Binding if
Native
Value
Used

Duration

java.lang.Long

Formats using IBM
TRIRIGA-preferred format
(e.g. 2 weeks, 3 days) and
considers user's language

N/A

Decimal

(A single value that
encodes the various
Duration components
in to a single value. It
is stored in the IBM
TRIRIGA database to
represent a particular
duration value. Be
careful when using
this value for anything
because it may not
represent the total
number of
milliseconds for the
particular duration.)
Classification

java.lang.String (nontranslated value)

BO Field option full
hierarchy path and user's
language

N/A

String

List

java.lang.String (nontranslated value)

User's language

N/A

String

Boolean

java.lang.Boolean

N/A

N/A

Boolean

Image

byte[]

Returns path to image as
stored in IBM TRIRIGA
database
(e.g. //Company1/file1309476206460.gif)

N/A

Image

Binary

byte[]

String representation of
the content ID, the key of
the DM_CONTENT table

N/A

Blob
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Business
Object Field
Type

getNativeValue()
Result

Considerations for
toString()

Additional
Methods

Suggested
BIRT
Binding if
Native
Value
Used

UOM

java.lang.String

getUomValue() translated
to the current user's
language

getUom().getUom
TypeCode()

String

(non-translated value,
same as
getUomValue())

getUom.getUom
Value()
getUomValue() is
NULL if there is no
value

Password

java.lang.String

N/A

N/A

String

SystemField_
BoRecordId

java.lang.Long

N/A

N/A

Decimal

SystemField_
FormId

java.lang.Long

N/A

N/A

Decimal

SystemField_
ModifiedDate
Time

java.sql.Date

User's timezone and
preferred display format

N/A

Date Time

SystemField_
CreatedDate
Time

java.sql.Date

User's timezone and
preferred display format

N/A

Date Time

SystemField_
ModifiedDate
TimeNumber

java.sql.Date

User's timezone and
preferred display format

N/A

Date Time

SystemField_
CreatedDate
TimeNumber

java.sql.Date

User's timezone and
preferred display format

N/A

Date Time

SystemField_
ProjectId

java.lang.Long

N/A

N/A

Decimal

SystemField_
BoTypeId

java.lang.Long

N/A

N/A

Decimal

SystemField_
Parent

java.lang.Long

N/A

N/A

Decimal
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* The following example is an expression that gets the Minute value from an IBM TRIRIGA Time's nativevalue:
importPackage(Packages.java.util)
sqlTime = dataSetRow["loTestQuery__MainBO____qtTime"].getNativeValue()
cal = Calendar.getInstance(new SimpleTimeZone(0, "GMT"))
cal.setTimeInMillis(sqlTime.getTime())
cal.get(Calendar.MINUTE)

Parameters
In IBM TRIRIGA, query/report input parameters filter the data returned from the defined query. In the
IBM TRIRIGA Report Manager, you use the User Filters area in the Filters tab to configure the
query/report filters. Filtering the data as much as possible in the Report Manager allows BIRT to deal
with as little data as possible.

If a BIRT data set models an IBM TRIRIGA query and that query has user-input filters,
each filter displays in two places in the starter report:


In the Data Explorer tab, as a top-level entry in the Report Parameters folder.
This top-level report parameter defines the user prompt that displays prior to
the report execution.



In the Parameters section, as a parameter of the data set that models the IBM
TRIRIGA query. This entry passes the report parameter value specified by the
user to the data set.

When a filter is required, the IBM TRIRIGA Query user filter presents as a user prompt
when the report executes, then passes through to the IBM TRIRIGA query engine,
filtering the results based on the IBM TRIRIGA query definition.
The default label for these fields is the Business Object Field's label. You may want to
add a custom label and Help Text for these report parameters.
If a report has multiple user filters on the same field (for example, Start Date
(triStartDA with a Filter Operator of More Than or Equals), and Start Date
(triStartDA with a Filter Operator of Less Than or Equals)), they will both appear in
the report. BIRT uniquely identifies them with a suffix corresponding to their position
in the query. For example, a parameter named
Classification_triFiscalPeriods_triStartDA, and a parameter named
Classification_triFiscalPeriods_triStartDA_2.
When you work with filters and parameters in a BIRT report, be aware that:


BIRT provides no means to differentiate between a filter to ignore and a NULL
filter value. IBM TRIRIGA supports ignoring a filter, so if you select NULL for a
report parameter that maps to an IBM TRIRIGA query filter, the IBM TRIRIGA
system ignores the filter.
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For Text parameter types, you can specify a value of NULL and the IBM TRIRIGA
query engine treats the filter value as NULL.



The IBM TRIRIGA-BIRT integration does not process the Time parameter filter
correctly if it is set as a Time data type. The TRIRIGA BIRT viewer does not
display an error, but it does not filter the results properly. For correct results,
use a String data type for the Time parameter.



The IBM TRIRIGA-BIRT integration does not process non English date/date time
formats on Date and Date Time filter parameters correctly if they are set as a
date or date time types, respectively. For correct results, use a String data
type for the Date and Date Time filter parameters.

Context
A data request from IBM TRIRIGA needs context. Current user is required context for
the request. There may also be record and project context.
User
The BIRT preview environment provides the user context from the IBM TRIRIGA BIRT
Preferences.
The IBM TRIRIGA runtime environment implicitly gets the user context from the
currently signed-in user.
Record
In both the BIRT preview and IBM TRIRIGA runtime environments, record context
passes through the BIRT report as a report parameter and down to the data sets.
Be aware of the following:


A
starter
report
for
a
query
has
a
non-required,
hidden
system__parentRecordId report parameter. For the query data set, it has a
system__parentRecordId input parameter. When the report executes, if a
non-zero value is passed through the parameter to IBM TRIRIGA, it becomes the
$$RECORDID$$ value when the IBM TRIRIGA query runs.



A starter report for a form has a required report parameter named
system__recordIds. This is a comma-delimited list of record ids that the
form report renders. You can use multiple IDs for the bulk-reporting
requirements.



In a BIRT preview environment, a prompt asks for the system__recordIds
value in order to preview the form report. For example, system_recordIds
1590609, 1345105, 1295530.



Even though the report has a parameter configured as not-hidden in the report
definition, this particular prompt does not present inside an IBM TRIRIGA
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runtime environment because the IBM TRIRIGA runtime environment provides
the value.
Project
In the BIRT preview environment, you can specify a project context in the IBM
TRIRIGA BIRT Preferences using the Project ID input. The BIRT preview environment
uses the Project ID input to provide project context for any IBM TRIRIGA requests.
In the IBM TRIRIGA runtime environment, the project context uses standard IBM
TRIRIGA conventions of looking at both the Home Page project context and any
applicable parent record.

System Fields
Some fields built in to a BIRT report are not backed by IBM TRIRIGA Business Object
fields. These are system fields, with special names that have special meaning to the
IBM TRIRIGA-BIRT integration.
System Field

Where Used

Description

system__recordIds

Data Set Input
Parameter for
Business Object
data sets

Comma-delimited list of record IDs that control the
records returned from Form reports. Required if
you do not use the system_recordId input
parameter.

Report Input
Parameter for
Form Reports
system__recordId

Data Set Input
Parameter for
Business Object
data sets

Numeric value representing a single record to
return from a Business Object data set. For a query
report, this field is required. For a form report, this
field is required if you do not use the
system_recordIds input parameter.

system_parentRecordId

Data Set Input
Parameter for
query data sets

Provides record context to reports and data sets.

Data Set Input
Parameter for
smart section data
sets

For Smart Sections, this is a required value that
controls which record's section data to return.

Report Input
Parameter for
Query Report

For Query data sets, this drives $$RECORDID$$ and
$$PARENT variables used within an IBM TRIRIGA
Query definition.
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System Field

Where Used

Description

system__recordId

Output Column for
all types of IBM
TRIRIGA data sets

Every IBM TRIRIGA data set has an output column
named system_recordId. This column contains
the record ID of the returned record. The only case
where this column is returned with a NULL value is
for a non-pass through reference with modify smart
section. In that case, there is no backing IBM
TRIRIGA record.

system__sourceRecordId

Data Set Output
Column for smart
section data sets

Every smart section data set has an output column
named system_sourceRecordId. This value
holds the data that a smart section record was
initialized from, the source record. For some
section types, this helps to differentiate the section
record from the source record.

Globalization
The starter report and the IBM TRIRIGA-BIRT integration have features to assist with
the globalization of reports. Before you export labels for BIRT reports, make sure that
these reports are set up in IBM TRIRIGA. For more information, go to the IBM TRIRIGA
Application Platform 3 Knowledge Center and select Administering IBM TRIRIGA
Application Platform > Globalizing applications.

Sub-reports
The IBM TRIRIGA-BIRT interface supports one-to-many nesting of IBM TRIRIGA data
sets. You can build the sub-reports into the top-level report or have them reside in
separate reports (separate .rptdesign files).
For example, a report might need to show purchase order headers and, for each
header, to show the line items for that particular purchase order. In this case, the
purchase order line Items display as a sub-report of the purchase order header data.
Single Report
You can build sub-reports into the same report (.rptdesign file) as the main report. A single report
might show fiscal years and fiscal quarters, where fiscal years are the parent records and the report
displays the fiscal quarters for each fiscal year. Fiscal years appear on the left side and each year's
quarters appear on the right side.

Be aware that:
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The parent data set has the record's ID returned on each result. This
functionality is built in to all IBM TRIRIGA query data sets as part of every
starter report.



The child IBM TRIRIGA query filters results based on the parent record.



The child data set takes a parent ID as a parameter. All IBM TRIRIGA query data
sets include this functionality as part of every starter report. Be aware that if
BIRT sends a system_parentRecordId with its default value of 0, the IBM
TRIRIGA system ignores it.



In the report layout's child table, the Data Set Parameter Binding binds the
parent record's ID to the child data set's input parameter.

Separate Report Files
You can build sub-reports into different .rptdesign files. For example, you can
show all fiscal years in a single list, and use a hyperlink to take the user to a pop-up
of the quarters for the selected year. In this case, the Fiscal Quarters is a separate
.rptdesign file.
Be aware that:


At the top-level of any zipped file that you import back into IBM TRIRIGA, there
must be at most one .rptdesign file. This tells IBM TRIRIGA runtime which
.rptdesign file to use when a report or form references the zipped file. Any
sub-reports in other .rptdesign files must be in a child directory. For
example, if the sub-report exists in a child directory named Subreports, the
name of the directory is unimportant as long as the sub-report files are not at
the top level of the project.



When you configure the hyperlink, the system__recordId from the top-level
report
(for
example,
Fiscal
Years)
must
be
bound
to
the
system__parentRecordId report parameter of the sub-report (for example,
Fiscal Quarters).

Performance Considerations
When you use the nested IBM TRIRIGA query approach to implement sub-reports, it is
important to understand that the child IBM TRIRIGA query re-executes for each parent
record. For example, if the report presents 50 fiscal years, 50 queries will execute to
get the fiscal quarters, one for each fiscal year.
Consider the following factors when you design sub-reports:


The requirements: For a particular report, is it more important to get the
entire report to the user as quickly as possible or is it more important to
minimize impact (CPU and memory) on the BIRT engine? If minimizing CPU and
memory impact is of critical importance, the nested IBM TRIRIGA query
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approach could be a good option since it places most of the burden on the
database.


The anticipated number of parent records: When a child query will execute
once for each parent record, the anticipated number of parent records
becomes a very important design consideration.



The complexity of the child query: If the child query is very complex, running
it repeatedly may be overly-taxing to the database.

Alternatives to the nested IBM TRIRIGA query approach include:


Use IBM TRIRIGA multi-business object queries combined with a BIRT grouping.
For example, a single IBM TRIRIGA multi-business object query might join Fiscal
Years and Fiscal Quarters. The BIRT report could then group on Fiscal Year, and
display the quarters for each year.



Fetch all the fiscal years and quarters at once, one query each, and then join
them inside the BIRT report. For example, you could display the parent records
from the Fiscal Years data set and display the child records (such as quarters)
from the in-memory join on years and quarters.

Custom Functions
Custom functions assist you with particular use cases. The custom functions reside in
the TRIRIGA sub-category of the BIRT Expression Builder.
The following table describes the custom functions.
Name

Description

Inputs

Return

formatNumber

Uses IBM TRIRIGA to
format a Number.

number - BigDecimal: Number
value to format

String: the formatted
number

unitOfMeasure - TriResultUom:
Unit of Measure on which to base
formatting. Can use a NULL value
if no UOM is available, but must
use the encodedBoFieldName
input.
encodedBoFieldName - String
[optional]: BO Field from which
this number came. Use where
applicable, because a field
metadata can affect number
formatting.
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Name

Description

Inputs

Return

formatDate

Uses IBM TRIRIGA to
format a Date.
Takes into account
the user's preferred
format, as specified
in the user profile
record.

date - java.util.Date: Date to
format

String: the formatted
date

formatDateTime

Uses IBM TRIRIGA to
format a DateTime.
Takes into account
the user's preferred
format, as specified
in the user profile
record.

dateTime - java.util.Date:
DateTime to format

String: the formatted
DateTime

getProjectIdForRecord

Returns record ID of
the project that the
specified record
resides within.
Returns NULL if the
record is not in a
project.

ID of the record. This is typically
the system__recordId value of an
IBM TRIRIGA result record.

Decimal: the ID of
the Project the
record resides within

getRootOrganizationId

Returns record ID of
the root
Organization.

N/A

Decimal: the ID of
IBM TRIRIGA's root
organization record

getCompanyLogoId

Returns the ID of
the Company Logo
document.

N/A

Decimal: the ID of
the company logo
document

getProjectLogoId

Returns the ID of
the current
project's logo
document.

N/A

Decimal: the ID of
current project's logo
document

getUserId

Returns the ID of
the currently
signed-in user.

N/A

Decimal: the ID of
the current user

getProjectId

Returns the ID of
the current project.
Returns NULL if the
user is not currently
in a project.

N/A

Decimal: the ID of
current project
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FormatNumber
When you aggregate numbers inside of BIRT, you use the formatNumber() function
to format those numbers so that the aggregate displays in the IBM TRIRIGA userpreferred format.
For example:
TRIRIGA.formatNumber(
row["triPeople_triPeople_triApprovalAmountNU"].getNativeValue(),
row["triPeople_triPeople_triApprovalAmountNU"].getUom(),
"triPeople_triPeople_triApprovalAmountNU")

FormatDate and FormatDateTime
To format a date that did not originate inside IBM TRIRIGA, you use the FormatDate
and FormatDateTime() functions.
For example:
TRIRIGA.formatDateTime(BirtDateTime.now())

GetProjectIdForRecord
To access the Project data for a particular record, you use the
GetProjectIdForRecord() function.
For example:
getProjectForRecord(row[system__recordId])

GetRootOrganizationId
To access the root-org, you use the GetRootOrganizationId() function.

For example:
getRootOrganizationId()

GetCompanyLogoId
To access the ID of the Company Logo document, you use the GetCompanyLogoId() function.

For example:
getCompanyLogoId()
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GetProjectLogoId
To access the ID of the current project's logo document, you use the GetProjectLogoId() function.

For example:
getProjectLogoId()

GetUserId
To access the ID of the currently signed-in user, you use the GetUserId() function.

For example:
getUserId()

GetProjectId
To access the current project, you use the GetProjectId() function.

For example:
getProjectId()

Preview Report
To preview a report, you use the Preview tab in the BIRT Report Designer. The values
you set as the IBM TRIRIGA BIRT Preferences in the BIRT application allow you to pass
context from IBM TRIRIGA to a BIRT report during preview execution. You set these
preference values when you specify the connection information to the IBM TRIRIGA
server, as described in the Install the IBM TRIRIGA Plug-In section.
You can pass these types of context:


Current user– Set when you specify the IBM TRIRIGA App Server, Username,
and Password field values.



Active project– Set when you specify the record ID of a particular project. This
causes the preview to simulate execution within the context of the specified
Capital project.



Input parameters – Prompted by the BIRT application. When you preview the
report, the BIRT application prompts for any input parameters that are defined on
the report. Those values also serve as context to the report execution.
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Export the BIRT Report
You need to export the BIRT report back to IBM TRIRIGA so the IBM TRIRIGA environment can use it.

Package the Report
Before you export the BIRT report back to IBM TRIRIGA, you package the report as a
.zip file:
Step 1

In BIRT, right-click the Report Project and select Export.

Step 2

Expand the General folder, select Archive File, and click Next.

Step 3

In the left pane, select ReportBuilding.

Step 4

In the right pane, select the .rptdesign and tririgalabels.properties
files.

Step 5

In the To Archive File field, name the new .zip file, and select the upload
location.

Step 6

In the Options area, select the options to use.

Step 7

Click Finish.

Upload the Report to IBM TRIRIGA
To upload the report, sign in to IBM TRIRIGA, navigate to the Document Manager, and
upload the packaged .zip file. For more information, go to the IBM TRIRIGA
10Knowledge Center and select Managing documents.
To upload the report to IBM TRIRIGA:
Step 1

In IBM TRIRIGA, open the Document Manager.

Step 2

Expand the IBM TRIRIGA folder.

Step 3

Select or create the upload folder. You can use a folder name that corresponds
to the module of the starter report and IBM TRIRIGA query.

Step 4

Click New Document.

Step 5

Click Browse and select the BIRT report file.

Step 6

Specify a Document Name.

Step 7

Optional: Specify additional field values.

Step 8

Click Upload.
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Step 9

When the upload process completes, click OK.

Upload Report Libraries
A report library is a BIRT construct that holds reusable components that you want to
share across multiple reports. The IBM TRIRIGA-BIRT integration supports report
libraries.
You upload a report library in the same way you upload a report (see Upload the
Report to IBM TRIRIGA), with the following specifics:


You must upload the report libraries separately to the IBM TRIRIGA Document
Management system directly under the folder \ROOT\TRIRIGA\BIRT
Libraries. If this folder structure does not already exist in your system, you
must create it.



The report library can be uploaded either as a single .rptlibrary file or, if
the library utilizes other resources (properties files, etc.), as a .zip file.



The name of the IBM TRIRIGA document must be the same as the name of the
publicly-accessible .rptlibrary file.



If the report library contains labels, the IBM TRIRIGA-BIRT solution supports
translation of the labels. The .rptlibrary file can reference a
tririgalabels.properties file that can have translatable labels. For
example, the library can contain a Master Page with header and footer
information that needs to display on all reports.

Associate Document to an IBM TRIRIGA Access Point
The final step for making the BIRT report usable is to associate the IBM TRIRIGA
document to an IBM TRIRIGA access point, either an IBM TRIRIGA query report or form
report.

Associate to a Query Report
You need to create an IBM TRIRIGA query as an external query. This query will act as
a link to the BIRT .rpt file that you uploaded to the Document Manager. You select
the BIRT report from the Document Management catalog. You can use the report in
many places throughout the IBM TRIRIGA system, such as Form sections and Portal
sections.
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To associate a BIRT report to an IBM TRIRIGA query:
Step 1

In IBM TRIRIGA, open the Report Manager.

Step 2

Select the System Reports tab.

Step 3

Click New.

Step 4

In the General tab:

Step 5

Step 6



Specify the Nameof the report. Names must be unique. Use the naming
conventions described in the Naming Conventions section in this user guide.



Specify the IDto further identify the report. Use CUSTOM or your company’s
numbering standards for reports.



Specify the Header (Title). This is the text that shows at the top of the
report.



To use an additional grouping for filtering, specify the Tag.



Specify a complete Descriptionof the report.



In the Type field, select External.

In the Business Objects sub-tab:


Click Add Business Object.



Select the Module, Business Object, and Form that correspond to the
context of the report. This categorizes the report for future retrieval in the
Report Manager.

In the Options sub-tab:


In the Document field, click the search



Select the.zip file that you uploaded to the Document Manager in Upload
the Report to IBM TRIRIGA and click Accept.



Optional: To execute the report asynchronously and notify the user when
the report is ready to view, select Queued. Consider running reports that
take more than a minute to run asynchronously instead of synchronously.
Running a report asynchronously lets the report run on the server when the
server is not busy with other tasks.

icon.

If a queued report has runtime filters or BIRT filters, they present to the user
before the report queues, as they are for a non-queued report.
You can launch from and access queued BIRT reports from the following
places: My Reports, Manager query lists, Report Manager, and query sections.
You cannot launch from and access queued BIRT reports from the following
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places: Portal Sections (if a queued report is attached to a portal section, the
system launches it in a non-queued manner) and form actions.
When a queued report finishes processing, the system sends a notification to
the user’s Notifications portal section. To access the report, the user clicks
the hyperlinked Subject.
A queued BIRT report attached to a workflow notification executes along with
the notification. However, if the report contains filters that do not have a
default value, the report generation may error out because there is no user to
provide the values. You need to set the default values for all filters when you
define such a report.
Step 7

Click Save and Close.

Associate to a Form
You select the BIRT report from the IBM TRIRIGA Document Management catalog. You
can use the report in many places throughout the IBM TRIRIGA system, such as Form
sections, Portal sections, and the Reports tab in most forms.



Note – If you need to use a BIRT report in a form section, the report must be added to
both the Layout tab and the Includes/Forms tab of the form. The Includes/Forms tab is
where you associate the BIRT report to the IBM TRIRIGA form. As a result, all the labels on
the BIRT report can be exported for translation from the Globalization Manager.

To associate a BIRT report to an IBM TRIRIGA form:
Step 1

In IBM TRIRIGA, open the General tab of the Form Builder.

Step 2

Open the form for which you developed the form report.

Step 3

Optional: Revise the form.

Step 4

To ensure that the report appears in the Reports tab of a form, select the
Layout tab, and select Show Reports.

Step 5

Select the Includes/Forms tab.

Step 6

In the Forms area, click Add.

Step 7

Select the report file that you uploaded into the Document Manager in Upload
the Report to IBM TRIRIGA and click OK.

Step 8

In the Forms area, select the report file.

Step 9

Select the Layout tab and click Publish.
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Configure Bulk Print after Object Migration
In the IBM TRIRIGA application, "bulk print" report actions use URLs with hard-coded numerical
document IDs (docId). As a result, there is a known issue that after you apply an object-migration
package, the docId of a document can change and its "bulk print" action no longer works. To remedy
this issue, you can manually update each docId, and associate each document with its related form.

Configure Bulk Print Actions in Maintenance Forms
To configure the actions in Maintenance forms:
Step 1

Sign in to the IBM TRIRIGA application as an administrator.

Step 2

In the Document Manager, navigate to TRIRIGA > Task.

Step 3

Right-click a document name from the following table, then select Properties, to obtain the
numerical docId of the document.
Repeat this step for each document in the following table.
Document Name

Bulk Print Action

Condition Assessment Work Task Record (BIRT)

Print Condition Assessment Work Task

Contract Review Record (BIRT)

Print Contract Review

Inspection Task Record (BIRT)

Print Inspection Task

Inventory Count Work Task Record (BIRT)

Print Inventory Count Work Task

Inventory Pick Work Task Record (BIRT)

Print Inventory Pick Work Task

Key Work Task Record (BIRT)

Print Key Work Task

Material Order Task Record (BIRT)

Print Material Order Task

Punchlist Task Record (BIRT)

Print Punchlist Task

Reserve Work Task Record (BIRT)

Print Reserve Work Task

Schedule Task Record (BIRT)

Print Schedule Task

Submittal Task Record (BIRT)

Print Submittal Task

Work Task Record (BIRT)

Print Work Task

Step 4

From the Tools menu, select Builder Tools > Form Builder. Select the triMaintenance
module. Open the triMaintenanceManager form and Revise the form.

Step 5

In the form navigation, select triSchedule > Work > My Tasks.

Step 6

In the My Tasks section properties, scroll to the bottom, and click one of the Bulk Print
actions. In the action properties, replace the old docId with the new docId.
Repeat this step for each action in the previous table.

Step 7

After all of the docId values are updated, Publish the form.

Step 8

Return to the Tools menu, select Builder Tools > Form Builder. Select the triTask module.
Open one of the Task forms from the following table and Revise the form. Select the
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Includes/Forms tab. In the Forms section, click Add. Locate the proper document and Publish
the form.
Repeat this step for each form in the following table.
Task Form

Document Name

triConditionAssessmentWorkTask

Condition Assessment Work Task Record (BIRT)

triContractReviewTask

Contract Review Record (BIRT)

triInspectionTask

Inspection Task Record (BIRT)

triInventoryCountWorkTask

Inventory Count Work Task Record (BIRT)

triInventoryPickWorkTask

Inventory Pick Work Task Record (BIRT)

triKeyWorkTask

Key Work Task Record (BIRT)

triMaterialOrderTask

Material Order Task Record (BIRT)

triPunchlistTask

Punchlist Task Record (BIRT)

triReserveWorkTask

Reserve Work Task Record (BIRT)

triScheduleTask

Schedule Task Record (BIRT)

triSubmittalTask

Submittal Task Record (BIRT)

triWorkTask

Work Task Record (BIRT)

Configure Bulk Print Actions in Invoice Forms
To configure the actions in Invoice forms:
Step 1

Sign in to the IBM TRIRIGA application as an administrator.

Step 2

In the Document Manager, navigate to TRIRIGA > Contract.

Step 3

Right-click a document name from the following table, then select Properties, to obtain the
numerical docId of the document.
Repeat this step for each document in the following table.
Document Name

Bulk Print Action

Asset Invoice Summary Bulk Print (BIRT)

Bulk Print Asset Invoices

RE Invoice Summary Bulk Print (BIRT)

Bulk Print RE Invoices

Step 4

From the Tools menu, select Builder Tools > Form Builder. Select the
triPayment module. Open the triProcessInvoices form and Revise the form.

Step 5

In the form navigation, select triGeneral > AR Invoices.

Step 6

In the AR Invoices section properties, scroll to the bottom, and click one of
the Bulk Print actions. In the action properties, replace the old docId with the
new docId.
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Repeat this step for each action in the previous table.
Step 7

After all of the docId values are updated, Publish the form.

Step 8

Return to the Tools menu, select Builder Tools > Form Builder. Select the triPayment
module. Open one of the Invoice forms from the following table and Revise the form. Select
the Includes/Forms tab. In the Forms section, click Add. Locate the proper document and
Publish the form.
Repeat this step for each form in the following table.
Invoice Form

Document Name

triAssetInvoice

Asset Invoice Summary Bulk Print (BIRT)

triREInvoice

RE Invoice Summary Bulk Print (BIRT)

Report Maintenance
You can make changes to existing reports that do not involve the data sets, and to reports that do.

Modify a Report without Data Set Changes
To modify a BIRT report that does not involve data set changes, you use the Document Manager to
check out the report file, make the changes, and re-import the report file. This process is described in
more detail.For more information, go to the IBM TRIRIGA 10Knowledge Center and select Managing
documents.
To modify the report:
Step 1

In the Document Manager, locate the report file, select the file, and click the
Check Out icon .

Step 2

Specify a Comment.

Step 3

Click Check Out.

Step 4

Follow the procedures in Create a Starter Report in IBM TRIRIGA and Import
the Starter Report into BIRT.

Step 5

Make any needed changes to the report and save the file.
If you made changes to a standard IBM TRIRIGA BIRT report, rename the report
before loading it into the Document Manager. This protects your customized
version in the case of an IBM TRIRIGA upgrade.

Step 6

To upload the new version, check the file back in to the Document Manager.
Start by selecting the Check In icon
.
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Modify a Report with Data Set Changes
To modify a BIRT report that does involve data set changes, you use the Document Manager to check
out the report file, make the changes, and re-import the report file. This process is described in detail
in the IBM TRIRIGA 10Knowledge Center underManaging documents.
Report modification can occur for many reasons and there are many ways to accomplish those changes.
This section describes one way.
To modify the report:
Step 1

Generate a starter report that is based on the same model you used for the
existing BIRT report, as described in Create a Starter Report in IBM TRIRIGA.

Step 2

Do one of the following, depending on the extent of your changes:
•

Select the updates to include by comparing the script-data-set elements in the current
BIRT report and the new .rptdesign file.
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•

Completely replace the script-data-set elements of the current .rptdesign file with
those generated in the new .rptdesign file. To do this, you import the starter report
into a project, copy the data set from the new starter report, and paste it in the data sets
of the existing .rptdesign file.

If you add fields or user filters to the IBM TRIRIGA query, you must also
change the report. After you update the data set, if that data set is used to
join inside BIRT, you need to rejoin the data set, and rebind the elements in
the BIRT report that reference that data set.
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Appendix A – Filter Operators
The values available as filter operators depend on the field type of the selected field.
The following table lists and describes the values that you can use.
Operator

Description

After

Available for date; date and time; and time fields. It is true if the
value of the specified field is after the specified value.

Before

Available for date; date and time; and time fields. It is true if the
value of the specified field is before the specified value.

Contains

Available for Text, UOM, and Boolean fields. It is true if the value of
the specified field contains the specified value.

Contains – Case Sensitive

Available for Text, UOM, and Boolean fields. It is true if the value of
the specified field contains the specified value, case-sensitivity
included.

Does Not Contain

Available for Text, UOM, and Boolean fields. It is true if the value of
the specified field does not contain the specified value.

Does Not Contain – Case
Sensitive

Available for Text, UOM, and Boolean fields. It is true if the value of
the specified field does not contain the specified value, casesensitivity included.

End With

Available for Text, UOM, and Boolean fields. It is true if the value of
the specified field ends with the specified value.

End With – Case Sensitive

Available for Text, UOM, and Boolean fields. It is true if the value of
the specified field ends with the specified value, case-sensitivity
included.

Equals

True if the value of the specified field is equal to the specified
value.

In

True if the value of the specified field is one of the specified values.
For string and numeric values, the specified values should be
comma-separated literal values, wrapped in single quotes. For
example: 'Tom','Jerry','Paul','1','2','3'.

Less Than

Available for number fields. It is true if the value of the specified
field is less than the specified value.

Less Than or Equals

Available for number, date, date and time, and time fields. It is true
if the value of the specified field is less than or equal to the
specified value.
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Operator

Description

More Than

Available for number fields. It is true if the value of the specified
field is greater than the specified value.

More Than or Equals

Available for number, date, date and time, and time fields. It is true
if the value of the specified field is greater than or equal to the
specified value.

Not Equals

True if the value of the specified field is not equal to the specified
value.

Not In

True if the value of the specified field is not one of the specified
values. For string and numeric values, the specified values should be
comma-separated literal values, wrapped in single quotes. For
example: 'Tom','Jerry','Paul','1','2','3'.

Start With

Available for Text, UOM, and Boolean fields. It is true if the value of
the specified field begins with the specified value.

Start With – Case Sensitive

Available for Text, UOM, and Boolean fields. It is true if the value of
the specified field begins with the specified value, case-sensitivity
included.
If this is a query that is used in a locator field or a smart section and
you notice that autocomplete takes a long time to execute, consider
changing the filter Operator from Contains to Start With.
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Appendix B – Special Values
In addition to using numbers and text in the Value field, there also are special values
you can use. The following table lists and describes these special values.
Value

Description

$$TODAY$$

Used to compare a date to the current date. For example, if you do
not want to display training courses that have started in the past,
specify: General::Start Date After $$TODAY$$

$$THISWEEK$$

Used to compare a date to the current week. For example, to see
training courses that start in the current week, specify:
General::Start Date Equals $$THISWEEK$$

$$THISMONTH$$

Used to compare a date to the current month.

$$THISYEAR$$

Used to compare a date to the current year.

The preceding special values can be followed by a + or - and a whole number. For example,
$$TODAY$$+1 is tomorrow, $$THISWEEK$$-1 is last week, and $$THISYEAR$$+5 is five years
after the current year.
$$RUNTIME$$

$$RUNTIME$$ tells the system that when the report is run the user
will be able to specify a value for the filter. If the user does not
specify a value, the system ignores the filter.
$$RUNTIME$$ works well with most data types and comparison
operators. However, for text data, the $$RUNTIME$$ value works
particularly well with the Contains operator.
Instead of using $$RUNTIME$$, you can identify fields for user input
by checking the User check box in the Filters tab.

$$USERID$$

$$USERID$$ is a valid field filter in queries. It tells the system that
a record passes the filter if it represents the user who is currently
logged in.

$$USERID::SectionName::Fiel
dName$$

$$USERID::SectionName::FieldName$$ is a valid filter in
queries. Setting the Value field to
$$USERID::SectionName::FieldName$$ indicates that a value
should be compared with the field name FieldName in the
SectionName section of the record of the person who is currently
logged in.
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Value

Description

$$PERSONID$$

$$PERSONID$$ is a valid field filter in queries. When this is used, it
resolves to the Smart Object ID of the person that is associated to
the current user. If the current user is not associated to a person, an
error is displayed.
Similar to $$USERID$$, it also supports section and field access.
One example of valid notation to resolve the first name of the
current person is: $$PERSONID::Detail::triFirstNameTX$$.

$$PARENT::SectionName$$

$$PARENT::SectionName$$ is a valid field filter in queries.
Setting the Value field to $$PARENT::SectionName$$ indicates
that a value should be compared with the SectionName section of
the record that contains the query section or smart section.

$$PARENT::SectionName
::FieldName$$

If you need a filter that compares a value in the record being
filtered with a value in the record that contains the smart section,
there is a special way of indicating it.
To indicate that a value should be compared with the field named
FieldName in the SectionName section of the record that contains
the query section or smart section, you would put the following in
the Value field: $$PARENT::SectionName::FieldName$$.
If the value of $$PARENT is empty, it resolves to an IS NULL
criteria.

Formulas as Field Values in Numeric Query Filter
You can use a formula as a field value in a numeric query filter. For example, you can
set a field value in a numeric filter to
$$PARENT::RecordInformation::triPlannedStartDate$$ - $$TODAY$$,
and the value at runtime resolves to a duration of today subtracted from the parent’s
value of Planned Start Date.
The special values that you can use in a numeric query filter field value follow:


$$PARENT$$, if the $$PARENT$$ field referenced resolves to a numeric value



$$TODAY$$



$$THISWEEK$$



$$THISMONTH$$



$$THISYEAR$$
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The expression supports any expression that is supported by the extended formula
builder. For information about extended formulas, see the Application Building for
the IBM TRIRIGA Application Platform 3: Calculations book.
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For example, the following formulas are valid:


AddDay($$TODAY$$,5)



AddYear($$PARENT::RecordInformation::triPlannedStartDate$$,
5)

If you plan to use a formula as a field value in a numeric query filter, be aware of the
following:


Date-based special values resolve to the beginning of their ranges. For
example, $$TODAY$$ resolves to midnight of the current day in the server’s
time zone. $$THISWEEK$$ resolves to midnight of Monday of the current week
in the server’s time zone.



This functionality is not supported in a date query filter. Date query filters do
not support these complex expressions.



The +/- capability available in a date field behaves differently in a numeric
filter field value than in a date filter field value. For example,
$$THISYEAR$$+5 in a date filter field means 5 years beyond the current year.
$$THISYEAR$$+5 in a numeric filter field value means 5 milliseconds after
midnight of January 1 of this year.
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Appendix C – Special Names in Record Field
The value of the Record / Query field must be the name of the other query to run . If
the value of the Filter Type field is Query, set the Record / Query value by clicking
the Search icon
and selecting the appropriate query.
If the value of the Filter Type field is Record, the value of the Record / Query field
determines if the association that this filter requires is directly with the context
record, with another record that is associated with the context record, or a totally
unassociated record.
In the Record field, you can use some special names to filter for an association with
some special records. The special names follow.
Value

Description

$$USERID$$

When the query is run, a value of $$USERID$$ resolves to the
record ID of the user that invoked the query.

$$PERSONID$$

When the query is run, a value of $$PERSONID$$ resolves to the
record ID of the People record that is associated to the user that
invoked the query.

$$RECORDID$$

This is useful for queries used in query sections and for Find action
queries for data sections. Queries used in query sections and find
queries are often required to return only records that are associated
with the record that contains the section.
Setting the Record field to $$RECORDID$$ means that the top-level
records pass this filter if they are associated directly with the
context record.

$$GROUPID$$

Setting the Record field to $$GROUPID$$ means that the top-level
records pass the filter if they are associated with a record that
represents a group of which the logged-in user is a member.
If the Record field is set to $$GROUPID$$, the Module field should
be set to Group and the Business Object field should be set to All.
Groups are tools for administering security in the IBMTRIRIGA
Application Platform.
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Value

Description

$$PROJECTID$$

Setting the Record field to $$PROJECTID$$ means that the toplevel records pass the filter if they are associated with a record that
represents the active project.
If the Record field is set to $$PROJECTID$$, the Module field
should be set to triProject and the Business Object field should
be set to All.
Projects in IBM TRIRIGA provide a way to classify data for relevance
to the tasks on which people work.

$$PARENT$$

Use $$PARENT$$ to specify that top-level records pass this filter if
they are associated with a record that has a direct or indirect
association with the context record. It works by specifying a path
from the context record to another record through record sections or
locator fields.
For example, suppose that the context record is an Employee record
and that the report only should include Employee records for
employees who have the same supervisor as the context record.
To specify a filter that does this, make use of the fact that Employee
records have a locator field named triReportsToTX that
references the record that corresponds to an employee’s supervisor.
If triReportsToTX were in the General section, the value of the
Record field would be
$$PARENT::General::triReportsToTX$$.
If the reference was a smart section, the value of the Record field
would be $$PARENT::triReportsTo$$.
If the value of $$PARENT$$ is empty, it resolves to an IS NULL
criteria.

$$PARENT::SECTIONNAME$$

Used to filter a Find section based on values in another section.
PARENT is always the word “PARENT”. SECTIONNAME is the name of
the section containing the values by which you want to filter. Make
sure you use the Name and not the Label of the section.

$$PARENT::SECTIONNAME::FI
ELDNAME$$

Used to filter a Find section based on the value of a field in another
section. PARENT is always the word “PARENT”. SECTIONNAME is the
name of the section containing the field by which you want to filter.
FIELDNAME is the name of the field by which you want to filter.
Make sure you use the Name and not the Label of the section and
field.

$$ORGANIZATIONID$$

Used to filter a portal query section based on the Organizations of
the user who is currently logged in.
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Value

Description

$$ORGANIZATIONIDWITHCHIL
DREN$$

Used to filter a portal query section based on the Organizations,
including all dependent child Organizations, of the user who is
currently logged in.

$$GEOGRAPHYID$$

Used to filter a portal query section based on the Geographies of the
user who is currently logged in.

$$GEOGRAPHYIDWITHCHILDR
EN$$

Used to filter a portal query section based on the Geographies,
including all child Geographies, of the user who is currently logged
in.
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Appendix D – Example of User Filters and
System Filters
The following example illustrates how to use User filters and System filters to yield
the desired result.
Assume that you want to query the triEmployee business object in the triPeople
module for only users whose first name is Bob or John, to filter out John Doe, and to
allow the end user the option to filter on the last name of the resulting list.
You define the query against triEmployee and specify that the triNameTx and
triLastNameTX display to the end user. Next, you define a User filter on the last
name field, so that the end users of this query can filter out Johns and Bobs, by last
name. To do this, you select the check box in the User column of the Columns section
next to the triLastNameTX field. The filter appears in the User Filter Columns
section. The configuration is complete.
Next, you need to set up the system filters so that only Johns and Bobs display and
that John Doe does not. To do this you need to create some filters. First, you lay out
the requirements for the filters in order to accomplish the task:
First name is Bob OR first name is John.
Last name must not be Doe if the first name is John (Bob Doe is OK).

This looks like four filters, one for each of the clauses. It also looks like two
groups, one for each bullet point. To write it out in a sentence form:
(First name is Bob OR first name is John) AND NOT (First name is John AND last
name is Doe).
Notice that there are three filters against first name and one against last
name.
You start by adding the first name and last name to the System Filter Columns list.
Then, you copy the first name filter twice.
Now that the raw materials are ready, you can manipulate to match the sentence:


Define the conditions.



Create the groups. To do this, you use the drop-downs in the third and the last
columns of the table. Since there is a parenthesis before the first condition in
your sentence and after the second condition, you put those in. The number
value in the drop-downs [i.e., the 1 in “1 – (“ ] is the number of parentheses
added. This allows for groups within groups.
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Setting the left-most parentheses drop-down indicates how many open
parentheses are in front of the filter but right after the operator. Setting the
right-most parentheses drop-down indicates how many close parentheses are
right after the filter.

Now that you have two groups, the next step is to set Boolean operators in the Join
Operator column:


Click Save. After the section reloads, the display reflects the groupings.



If you change the grouping on a filter, the system removes the group
visualizations to reduce confusion with pre-existing groupings.



Run the report to verify the result.
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